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Bu bölümde çeşitli GLPI uygulama ekleri ile ilgili belgeleri bulabilirsiniz.

Eğitimler 1
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BÖLÜM 1

Giriş

Uygulama ekleri ile çekirdek kaynak kodu değiştirilmeden`GLPI <http://glpi-project.org>`_ kullanım alanları geniş-
letilebilir. Kusursuz bir dünyada çekirdek kodu herkes (ya da çoğu kişi) tarafından kullanışlı bulunacak özellikleri
sağlarken belirli özellikler uygulama ekleri tarafından sağlanmalıdır.

Var olan uygulama eklerinin bazıları oldukça karmaşıkken bazıları da oldukça basittir. Bazı uygulama eklerini kulla-
nabilmek için önce belgelerini okumak gerekirken bazıları için gerekmez. . . Bazı uygulama eklerinde yapılandırma
seçenekleri, erişim izinleri yönetimi gibi ek ayarlar bulunur. . . Oldukça çok uygulama eki vardır!

Henüz GLPI çekirdeğinde bulunmayan bir özellik arıyorsanız uygulama ekleri deposuna. bakın. Uygulama eki adı,
özellik ya da uyumlu çekirdek sürümüne gibi ölçütlere göre arama yapılabilir.

Güncel belgelerin amacı, belgeleri bir araya getirmektir. Ancak tüm uygulama eki belgelerinin buradan sunulması
amaçlanmıyor.

Her neyse, mutllu GLPI kullanmalar!

3
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BÖLÜM 2

Empty

İndir Kaynaklar
ilgisiz https://github.com/pluginsGLPI/empty

Bu uygulama eki aslında. . . hiç bir şey yapmaz. Gerçekten!

Bu uygulama ekinde, geliştirmeye bir başlangıç noktası oluşturmak için kullanılabilecek şekilde bazı varsayılan betikler
ve öneriler bulunur. Uygulama eki olanaklarını öğrenmek istiyorsanız örnek uygulama eki bölümüne bakın.

2.1 Yeni bir uygulama eki oluşturmak

Yeni bir uygulama eki oluşturmak için plugin.sh betiği kullanılır. Betik çağrılırken bir uygulama eki adı, bir sürüm
ve isteğe bağlı olarak uygulama ekinin oluşturulması istenilen yol belirtilmelidir:

$ ./plugin.sh MyGreatPlugin 0.0.1

Betik yazdığınız adı arındırıp lüçük harfe dönüştürür, tema dosyalarını yeni klasöre kopyalar ve bazı değişiklikler yapar.

Betik hedef parametresi olmadan kullanıldığında kendi bulunduğu klasör içine mygreatplugin klasörünü ekler. Yol
belirtilmiş ise yeni klasör belirtilen yola eklenir:

$ ./plugin.sh MyGreatPlugin 0.0.1 /path/to/glpi/plugins/

5
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2.2 Var olan uygulama ekini güncellemek

Gözden geçirilmesi gereken çok sayıda durum olduğundan henüz var olan uygulama ekleri otomatik olarak güncelle-
nemiyor. Gene de sorun değil, işlem oldukça basit ;)

Boş özellikleri kullanmak bir kaç dosya oluşturmak kadar kolay:

• composer.json,

• .travis.yml,

• Robofile.php,

• .gitignore.

Herhangi bir composer ya da travis yapılandırma dosyanız yoksa, boş uygulama ekindeki dosyaları kopyalayın. Varsa;
composer.json dosyasına şunu ekleyin:

{
"minimum-stability": "dev",
"prefer-stable": true

}

Ardından composer require glpi-project/tools komutunu çalıştırın.

Travis yapılandırma dosyasına CS çağrısını ekleyin:

script:
- vendor/bin/robo --no-interaction code:cs

.gitignore dosyasına şunu ekleyin:

dist/
vendor/
.gh_token
*.min.*

Robo.li yapılandırma dosyasında, boş uygulama ekini gömmenin biraz incelikli olduğunu unutmayın. Sorunsuz çalış-
ması için düzenlemeniz gereken bazı şeyler var. Ayrıntılı bilgi almak için aşağıya bakın.

Son olarak tools projesi size bazı özellikler sunar. Uygulama ekinizde bulunabilecek çift araç betiği dosyalarını sile-
bilirsiniz (release`, extract_template.sh, gibi).

2.3 Özellikler

2.3.1 Kodlama standartları

GLPI PHP KodTarayıcı kural kümesi, vendor/glpi-project/coding-standard/GlpiStandard/ biçiminde su-
nulur.

Kodlama standartlarını denetlemek için Robo.li task code:cs kullanın:

$ ./vendor/bin/robo code:cs

Not: Yukarıdaki komut vendor seçeneğini yok sayar ve geçerli klasörde yürütülür.

6 Bölüm 2. Empty
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Yok sayma listesi ya da denetlenmiş klasörleri uygulamak istiyorsanız, uygulama ekinin RoboFile.php dosyasındaki
$csignore ve $csfiles değerlerini değiştirmeniz yeterlidir:

<?php

class RoboFile extends Glpi\Tools\RoboFile
{
protected $csignore = ['/vendor/', '/lib/'];
protected $csfiles = ['./', 'setup.php.tpl']
[...]

}

2.3.2 Otomatik denetimler

Kolaylık sağlamak için önceden hazırlanmış bir .travis.yml dosyası sunulmuştur ve şunları kapsar:

• Kodlama standartlarını denetler,

• Farklı yapılandırmalar üzerinde çalışır

Otomatik denetimlerin yapılabilmesi için site üzerinde travis-ci yapımlarını etkinleştirmeniz gerekir.

.travis.yml dosyası değiştirilebilir. Birim denetimleri yürütmek, bir veri tabanını oluşturmak ya da güncellemek,
bildirimleri etkinleştirmek gibi işlemler ekleyebilirsiniz. Ayrıntılı bilgi almak için Travis-CI belgelerine bakın.

2.3.3 CSS ve JS dosyalarını küçültmek

Uyarı: Robo kitaplıkları eskimiş olduğundan ve değiştirilemediğinden 0.1.13 sürümüyle birlikte devre dışı bıra-
kıldı.

Robo.li kullanan standart bir betik sunulmuştur. RoboFile.php` dosyasında Glpi\Tools\RoboFile (glpi-project/
tools bağlılığı tarafından sunulan) özelliklerini genişleten boş bir sınıf bulunur. Burada istediğiniz ayarları yapabilir-
siniz.

Böylece ortak dosyayı kolayca güncelleyerek kendi görevlerinizin aynı kalmasını sağlayabilirsiniz.

Gerekli kitaplıkların yüklenmesi için get composer <http://getcomposer.org>`_ yükleyip şunu çalıştırmalısınız:

$ composer install -o

Üç hedef seçilebilir:

• küçült tüm CSS ve JavaScript dosyalarını küçültür (aşağıya bakın),

• küçült:css uygulama ekinizin css klasöründeki tüm css stil sayfalarını küçülterek özgün dosyaların yanında
.min.css sürümlerini oluşturur.

• küçült:js uygulama ekinizin js klasöründeki tüm javascript dosyalarını küçülterek özgün dosyaların yanında
.min.js sürümlerini oluşturur.

Yalnız hedefi seçin ve şunun gibi bir şey çalıştırın:

$ ./vendor/bin/robo minify:css

2.3. Özellikler 7
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Not: Derlenmiş dosyaların depo kaynaklarınıza yüklenmeyeceğini unutmayın. Bu işlem yayınlamadan önce dosyaları
küçültmek içindir.

Ayrıca betiklerinizi varsa küçültülmüş sürümleri yoksa özgün sürümleri yükleyecek şekilde uyarlamayı unutmayın :)

GLPI 9.2 sürümünden itibaren, add_css ve add_javascript seçeneklerini kullanarak, küçültülmüş dosyaların yük-
lenmesi için herhangi bir ek işlem yapmanız gerekmez. Küçültülmemiş betiği çağırmanız yeterlidir. Varsa ve Hata
Ayıklama kipinde değilse GLPI küçültülmüş sürümü kullanır.

2.3.4 Çeviriler

GLPI ve uygulama eklerinin dil çevirileri için gettext kullanılır. Çevirilerin doğru çalışması için bir kaç adım gereklidir:

1 translatable strings must be extracted from source files, a POT file will be created or updated accordingly, 2 PO files
must be created or updated from the POT file, 3 PO files must be translated, 4 MO files must be compiled from the latest
PO.

vendor/bin klasöründe bulabileceğiniz extract_template.sh betiği ile kaynak kodunuzdaki çevrilebilecek dizge-
leri ayıklayabilirsiniz (yukarıdaki birinci adım).

Bu betik çalıştırıldığında locale/uygulamaekim.pot dosyası oluşturulur ya da güncellenir.

İkinci ve üçüncü adımlar için bir seçim yapmanız gerekir. PO dosyalarınızı güncellemek ve çevirmek için poedit; gibi
gettext araçlarını kullanabileceğiniz gibi`Transifex <http://transifex.com/>`_ ya da Zanata gibi çevrim içi çeviri sistem-
lerinden yararlanabilirsiniz. Şu anda Transifex üzerinde GLPI çekirdeği ve çoğu uygulama ekinin çevirileri bulunmak-
tadır.

PO dosyalarınızı güncelledikten sonra MO dosyalarını derlemelisiniz. Bu işlemi el ile yapabilirsiniz. Yayınlama betiği
bu dosyaları her durumda yeniden derler. MO dosyalarını derlemek bölümüne bakın.

2.3.5 Yayınlama betiği

vendor/bin/plugin-release klasöründe bir yayınlama betiği bulunur. “Basit” bir Python betiğidir. Sisteminizde
Python yüklü olmalıdır (çoğu linux dağıtımında varsayılan olarak yüklüdür).

Uyarı: Yayınlama betiğinin yalnız anlam bilimsel sürümleme ile uyumlu olduğunu unutmayın!

Yalnız varsayılan değerler kullanıldığında betik git deponuzdaki son etiketi almayı, üçüncü taraf bağlılıklarını eklemeyi
ve github projesinde Yayın sürümünü oluşturmayı dener:

$ ./vendor/bin/plugin-release
Do you want to build version 1.9.5? [Yes/no] y
Building glpi-order-1.9.5...
Archiving GIT tag 1.9.5
Adding vendor libraries
$ ls dist
glpi-order-1.9.5.tar.bz2 glpi-order-1.9.5.tar.bz2.asc

8 Bölüm 2. Empty
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Gereksinimler

Python derleyicinin şu modüller ile yüklenmiş olması gerekir:

• termcolor,

• gitdb,

• github (var olan sürümleri ve taslakları denetlemek ve github sürümlerini oluşturmak için ), --nogithub seçe-
neğini kullanmadığınız sürece

Betik ile ilgili yardım sayfasını görüntülemek için ./vendor/bin/plugin-release -h yazın.

Süreç

Yayınlama sürecinde şu işlemler yapılır:

• Sürüm sabitinin istediğiniz etiket ile aynı olup olmadığı denetlenir,

• Site XML dosyası sürümünün istediğiniz etiket ile aynı olup olmadığı denetlenir,

• Yerel ve uzak (projenizin pluginsGLPI kuruluşunda yayınlandığı ve herkese açık olarak yayınlandığı varsayıla-
rak) bir sürümün var olup olmadığı denetlenir,

• Devre dışı bırakılmamış yolların git arşivi of oluşturulur (.git, tools, tests, . . . ),

• Varsa derleyici bağımlılıkları yüklenir,

• Varsa, MO dosyaları derlenir,

• Varsa, CSS biçem sayfaları ve JavaScript dosyaları derlenir (Robo.li <http://robo.li> kullanılarak_),

• Tüm bunlardan bir yayın arşivi derlenerek Robo.li dist klasörüne eklenir,

• Arşivi imzalamak için GPG kullanın.

Not: Standart yayınlama sürecinde doğrudan dosyalarınız üzerinde çalışılmaz. Dosyalar önce dist/src klasörüne
kopyalanır. Bu işlemin uygulanmadığı tek durum MO derleme seçeneğidir.

Gerçek sürümü yayınlamadan önce her şeyin tamam olup olmadığını görmek için etiketinizi oluşturun ve ./vendor/
bin/plugin-release -C komutunu yürütün etiketinize push işlemi yapmadan önce. Böylece olası sorunları çöze-
rek etiketinizi yerel olarak yeniden oluşturabilirsiniz. (yayınlanan etiketlerin asla silinemediğini unutmayın).

MO dosyalarını derlemek

Yayınlama sürecinde locales klasöründeki her PO dosyası otomatik olarak derlenir. Ancak büyük olasılıkla deneme
amacıyla kaynak kodlarında son MO dosyalarının bulunmasını istersiniz. Yayınlama betiğinde bu işlemi gerçekleştirmek
için --compile-mo (ya da -m) seçeneği sunulur:

$ ./vendor/bin/plugin-release --compile-mo

Uyarı: Bu komut yukarıdaki diğer komutlar gibi uygulama eki dosyalarınızın kopyaları üzerinde değil, doğrudan
uygulama eki dosyalarınızın üzerinde çalışır.

2.3. Özellikler 9
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Ön yayınlar

Varsayılan olarak yayınlama betiği yalnız var olan etiketler üzerinde çalışır. Herhangi bir ön yayının kendi etiketi ol-
malıdır. Ancak bazı durumlarda herhangi bir etiketi olmayan bir yayın arşivi oluşturmak isteyebilirsiniz.

Yayınlama betiğinde bu işlemi gerçekleştirmek için bir kaç parametre belirtmeniz gerekir:

• --commit (ya da -c) commit karmasını verir,

• --release (ya da -r) yayın sürümünü verir (genellikle bir sonraki yayın sürümüdür),

• --extra (ya da -e) ek bir dizge belirtmek için kullanılır (alpha, beta, rc1 gibi)

Örnek olarak sipariş uygulama eki için:

$ ./vendor/bin/plugin-release --commit 632d515d4ac0 --release 1.9.5 --extra alpha1
$ ls dist
glpi-order-1.9.5-alpha1-20161103-632d515d4a.tar.bz2

Sürümleri imzalamak

Yayın sürümlerinin GPG anahtarı ile imzalanması kullanıcıların yüklemeden önce indirdikleri dosyanın sorunsuz ol-
duğunu anlamalarını sağlar. Bu işlem için herkese açık olarak sunacağınız bir GPG anahtarına gerek vardır. İmzalama
seçeneği varsayılan olarak etkindir. --nosign (ya da -S) seçeneği kullanılarak devre dışı bırakılabilir.

İmzanın bulunduğu dosya arşiv ile aynı adla ve .asc uzantısıyla dist klasörüne eklenir.

GitHub üzerinde yayınlamak

Yayınlama betiği --nogithub (ya da -g) seçeneği kullanılmadıkça GitHub deposu üzerinde bir taslak yayınlama
sürümü oluşturur.

Not: Maalesef, yeni sürüm için oluşturulmuş arşiv dosyasını henüz yükleyemiyoruz. . .Bu sorun ileride çözülebilir.

Bu özelliği kullanabilmek içn GitHub kurulmuş; ve erişim kodu alınmış olmalıdır. Her kullanıcıya bir erişim kodu
verilir ve depolarına ulaşması için kullanılır.

GitHub ayarları sayfasınıza giderek, personnal access token sekmesinden. generate new token üzerine tıklayın. Açık-
lamayı isteğinize göre yazın ve yalnız public_repo seçeneğini işaretlediğinizden emin olun (başka bir seçeneği işaret-
lemeniz gerekmez. Gerek duyarsanız bir kaç erişim kodu üretebilirsiniz).

Kod yalnız bir kez görüntülenir. kodu plugin klasörünüzdeki .gh_token dosyasına kaydederek işlemi tamamlayabi-
lirsiniz.

Katılmayacak dosyaları belirlemek

Uygulama ekinizin kök klasöründe bir .ignore-release dosyası oluşturabilir ve içine sürüm arşivine katılmasını
istemediğiniz dosya ve klasörleri yazabilirsiniz. Her satıra bir ifade yazın

.+\.png
screenshots/

Bazı dosyalar otomatik olarak katılmaz:

• .git*,
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• .gh_token

• .tx/

• tools/

• tests/

• .atoum.php

• .travis.yml

• .circleci/

• .ignore-release

• composer.lock

• Robofile.php

2.3. Özellikler 11
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BÖLÜM 3

Example

İndir Kaynaklar
ilgisiz https://github.com/pluginsGLPI/example

Örnek uygulama eki. . . GLPI çekirdeğinden uygulama ekleri ile yapılabilecek uygulamaları göstermek amacıyla geliş-
tirilmiştir.

Bu uygulama eki aslında bir şey yapmadığı için bir belgesi de yoktur. Geliştirmeye bir başlangıç noktası oluşturmak
için uygulama eki sunumu, uygulama eki geliştirici rehberi ya da boş uygulama eki belgelerine bakabilirsiniz.
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BÖLÜM 4

Centreon

Download Sources
https://github.com/pluginsGLPI/centreon/releases https://github.com/pluginsGLPI/centreon

4.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

4.2 Features

Centreon is a network, system, applicative supervision and monitoring tool. Centreon plugin allows you to see general
information about hosts and their services on your GLPI interface, as long as the items are both in GLPI and Centreon.

You can perform 3 main actions :

• Acknowledge a problem

• Schedule a downtime

• Trigger a host check,

and you can also see the timeline of the host.

15
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4.3 Installation

• Uncompress the archive

• Move the centreon folder to <GLPI_ROOT>/plugins directory

• Navigate to the Configuration > Plugins page,

• Install and activate the plugin.

4.4 Usage

You need to configure the plugin before using it. To do so, go to the Setup > Plugins > Centreon page. You will need
to fill the following fields :

• Centreon URL : The URL of your Centreon interface, following by the number of the port, and the API version
to use

• Centreon Username : The username of your Centreon account

• Centreon Password : The password of your Centreon account

Then, it will create automatically a new SQL table named glpi_plugin_centreon_hosts. This table will contain
all the hosts that are both in GLPI and Centreon. A new tab is created on the host page, so you can see the information
about the host.
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4.4. Usage 17

http://creativecommons.org/licenses/by-nc-nd/4.0/


GLPI plugins Documentation

18 Bölüm 4. Centreon



BÖLÜM 5

Credit

İndir Kaynaklar
https://github.com/pluginsGLPI/credit/releases https://github.com/pluginsGLPI/credit

5.1 Gereksinimler (özel kurulum)

GLPI sürümü En düşük PHP sürümü Önerilen
10.0.x 8.1 8.2

Not: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

5.2 Uygulama ekini kur

• Go to the marketplace. Download and install the plugin “Credit”.
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5.3 Setting up the plugin

5.3.1 Creating a credit type

• From Setup > Dropdowns,

• click on Credits then Credit types.

• Click on add.

• Enter a name representing the type of credit granted
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5.3.2 Add credit to customer entity(ies)

Example : We will create 3 types of credit:

• For a new follow-up

• For a new task

• For a new solution

You can create a single type of credit which will group together the 3, it depends on the management of
each case.

• In Administration > Entities, select the entity that will receive the credits.

• Go to the Credit section

• In the section Add a credit, enter a name for the new credit

• Define the type of credit created earlier

• The start and end dates of the credit

• Activate it,

• Make it available or not in the child entities (note that if you are in the parent entity, it will be accessible to all
entities)

• The quantity of credit sold

• The authorisation to overconsume or not

• Click on add

Here, we’ll do the same for the 3 types of credit (followup, task and solution)

It is therefore possible to enter different values (number of credits, validity, overconsumption, etc.) for each credit:

5.3. Setting up the plugin 21
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5.3.3 Define default values

• In Administration > Entities, select the entity that will receive the credits

• Go to the Credit section

• In the Default options for entity section

• Select the type of credit by action

• Click on Update

Uyarı: “Caution Indicating credit types does not allow automatic settlement. It pre-selects the credit but it must be
settled by the technician.

5.4 Counting credits

When a ticket is created, you can choose whether or not to deduct the corresponding credits.

In our example, we have chosen to deduct each action.

• If we are doing a follow-up, we can deduct the credit assigned by default:

• The same for a task:

• And for a solution :

In the Credit section of the ticket you can see a summary of credits spent and remaining
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5.5 Modify a credit on a ticket

5.5.1 Increase or decrease a granted credit

You can modify credits on a ticket if a readjustment is necessary.

• From the ticket in question, go to the credit section

• Select the credit you wish to adjust

• Click on Actions

• Click on Update

• Click on Quantity consumed then add the desired quantity

• Click on Send

Not:

See how to proceed
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5.5.2 Delete deducted credits

• From the ticket in question, go to the Credit section

• Select the credit you wish to delete

• Click on Actions

• Click on Delete permanently

• Click on Send

Not:

See how to proceed

Credits will be automatically reallocated in the credit bank

5.6 Including an expired credit

If the credit has expired, it will not be proposed in the list of available credits. You will not be able to deduct it. You
will need to change the end date of the credit to be able to use it again.

5.7 Notification of expired credits

An automatic action is available to notify you when a credit has expired.

• From Setup > Automatic actions, modify the creditexpired action to suit your needs.

• Click on Save

You can of course customise the notification to suit your needs (Setup > Notifications > Notifications > credit expired)

5.6. Including an expired credit 27
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5.8 FAQ

If you have any questions about using the plugin, please consult our FAQ
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BÖLÜM 6

Veri aktarımı

Download Sources
https://github.com/pluginsGLPI/datainjection/releases https://github.com/pluginsGLPI/datainjection

6.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

6.2 Plugin installation

• Go to the marketplace. Download and install the plugin Data Injection
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6.3 Rights management

Once the plugin has been installed via the marketplace, you can configure rights according to profile:

• From Administration > Profiles, select the profile in question

• Go to Data injection

For each user profile, you can grant the following rights:

• Model management : Read / Update / Create / Purge

• Import file : Read

6.4 Yapılandırma

You can find the plugin configuration at Tools > Data injection The extension is presented in the form of a wizard,
each operation is broken down into steps and it is possible to return to the previous step to correct a choice.

6.4.1 Managing or using a model

The first step allows you to choose the operation to be carried out, depending on your rights.

• Use an existing template in the drop-down menu

• Manage templates to :

– Create a new template

– Modify an existing template

– Delete an existing template

– Use an existing template
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6.4.2 Creating a template

The first step is to create a template if none exists.

• From Tools > Data injection

• Click on Template

• Click on Add

Defining the model

This step allows you to define the main options for the extension:

• Name: the name that will be visible from the drop-down list

• Visibility: defines whether it will be visible to other users or not

• Entity and sub-entity: the template can be visible in the creation entity only (sub-entity set to no) or in the entity
and all sub-entity (sub-entity set to yes).

• Comment: a comment for the template.

• Type of data to import: the type of data present in the file to be imported. A file only consists of data of the
same type.

• Allow lines creation: tells the plugin to create objects if the line does not correspond to an existing element in
the database.

• Allow update rows: tells the plugin to modify existing objects using the data in the file.

• Header’s presence: tells the plugin whether the headings present in the file (location, type of equipment, models,
etc.) should be created. Creation will also be limited by the rights of the template user.

• Update existing fields: the extension whether the data in the file can replace fields already filled in.

• Date format: the date format is contained in the CSV file. If the format is incorrect, the date cannot be imported.

• Decimal number format: the format used for the numbers in the CSV file. If the format is incorrect, the numbers
cannot be imported.

After validation of the model, the following fields are added:

• Presence of a header: indicates whether the first line of the CSV file is a header line, so that you can see the
contents of the columns to identify the contents of the columns

• File delimiter: field separator (by default a semicolon)
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File to be injected

• From the File to inject tab, you need to choose a file on your computer with exactly the same structure as the
data already imported.

• Then define the encoding (ISO8859-1 for Windows files, UTF-8 for Linux files. Automatic detection can be used
to determine the encoding, but will slow down file processing. We strongly recommend that you always work in
UTF-8.)

Once the file has been validated, you will be taken to the Mappings tab

Mappings

This stage is essential. It defines, for each column in the file, the corresponding field in the database. The columns are
identified by the content of the header line (presence defined in the previous step) or by their position (starting from 0).
A separator error (in the previous step) will result in an incorrect split. The View file button is used to preview the first
lines of the file and check their content and the interpretation made by the plugin.

For each column, you can choose

• Do not retrieve data from this column (leave the Choose a table option)

• Choose a table: the data type defined in step 2 or the financial information

• Choose a field: which will be populated by the import

• Link field: to indicate that this column will be used to check the existence of the data in the database and to choose
between creating a new object or update. Candidate fields are, for example, the Serial number, the Name or the
Inventory number

Uyarı: It is mandatory to define at least 1 linking field. If a field is checked, it must be entered in your csv file used
for importing.

Not: It is possible to define Comments or Notes as the destination for several columns in the file. Each column will be
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added to the field on a different line. This step is particularly important and a wrong choice could damage the inventory
data. It is therefore advisable to test the import on a test database or to and reserve this function for advanced users.

6.4.3 Additional information

This step is used to define the fields that can/should be populated by the user when a file is injected. For each field, the
same value will be used for each line of the file and will take precedence over the contents of the file.

• Table: the data type defined in step Matching

• Field: will be populated by the import

• Mandatory information: whether model user input is mandatory or optional

Example of use :

• Purchase date when importing a delivery note

• Comments to define a criterion that can be used in the search engine (e.g. IMPORT ON 31/10)

Model validation

From the Validation tab, you can confirm the registration. It is still possible to return to the previous steps to check and
correct certain options.

Uyarı: If you are working with a sub-entity, you must select the desired entity before importing.

Not: Some fields in your CSV file will need to be filled in as Booleans. This is the case, for example, with double-
choice fields, such as: “Ports” (serial/parallel/USB) for printers. Instead of entering Yes | No in your CSV, enter 1 | 0
as appropriate. If these values are not changed, you will see an error in the report indicating that the wrong type of data
has been entered.
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6.5 Using a template

6.5.1 Choosing a template

• From Tools > Data injection, select the template you require from the drop-down list

• Then enter the path to the CSV file to be injected

• Specify the Encoding of the file if you know it. If not, leave on Automatic detection

• Click on Proceed with import

Confirmation before import

A popup will ask you to confirm or not the import of the selected file.

6.6 İçe aktarma sonuçları

From this last stage, by clicking on the coloured circle, you can view a report on the import and, in particular, locate
any errors

6.7 Complete the operation

A popup window will ask you whether or not you want to confirm the import of the selected file. Once the progress bar
is full, click on Finish
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6.8 FAQ

If you have any questions about using the plugin, please consult our FAQ
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BÖLÜM 7

Düzey yükseltme

Download Sources
https://github.com/pluginsGLPI/escalade/releases https://github.com/pluginsGLPI/escalade

7.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

7.2 Install the plugin

• Go to the marketplace. Download and install the plugin Escalade.

37

https://github.com/pluginsGLPI/escalade/releases
https://github.com/pluginsGLPI/escalade
https://glpi-network.cloud/


GLPI plugins Documentation

7.3 Assign a ticket

Tüyo: Escalade vs business rules We advise you to use business rules to allocate tickets or escalations. This allows
you to manage more flexibly when changing category, urgency, etc.

Not: Escalade allows tickets to be escalated only to groups, and not to live users.

When the plugin is activated, a new option is available from the ticket interface :

7.4 Set plugin parameters

• From the plugin, click on the spanner and choose the various options that interest you:
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Action Effect
Remove old assign group on new group assign Deletes or not the existing groups when you assign a new

one
show group assign history visually

(valid only if previous option is set to yes)
Previous groups will be visible when a new
group is escalated

Assign ticket to initial group on solve ticket (valid only if previous option is set to yes) Reassigns tic-
ket to initial group if a group is deleted

Escalation history in tasks Keep or not the history of escalations in the tasks
Remove technician(s) on escalation Technician(s) will be deleted when a new technician is

added to the ticket
Ticket status can be changed after escalation Modify the status of the ticket after the escalation. A “do

not modify” option is also available.
Assign the technical manager on ticket category
change

If a technical manager is declared in an ITIL category,
they will be automatically assigned and will receive a
notification.

Assign the technical group on ticket category change If a technical group is declared for an ITIL category, it
will be automatically assigned and the members of the
group will receive a notification

Clone tickets Possibility of cloning tickets from the helpdesk interface
.. figure:: images/Escalade-4.png

Close cloned tickets at the same time Close all cloned tickets when one of them is closed
Use the technician’s group If a technician is assigned, their group will also be assig-

ned. You can choose to take account of the assignment
when the ticket is created and/or modified. You can also
choose to select the first or last group to which the user
is assigned

Remove requester(s) on escalation Remove requester(s) in the event of an escalation. Please
note that no history is kept, as is the case for assigning a
group

Display delete button
Displays the option of deleting ac-
tors from the ticket (ability to refine
which user/group/supplier by reques-
tor/watcher/technician)

Activate filtering on allocation groups Enables filtering and whether or not escalation to other
groups is possible. See next chapter for more information
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7.4.1 Setting up filtering

Filtering allows you to define which group is able to escalate tickets to other groups. For example, we don’t want N1
support to be able to escalate to N3 directly. The escalation to N2 must be mandatory.

• From Administration > Groups, select one of the groups

• In Escalade, add the groups to which this one will be able to escalate tickets.

Uyarı: This option can be useful, but it requires all groups to be set up. If, for example, the technician N1 group
can escalate tickets to the technician N2 group, you need to ensure that the technician N2 group can escalate tickets
to the technician N3 group and also to the N1 group, so that a ticket can be escalated if necessary.

Example :

• Joe user is added to group Groupe 1

• Groupe 1 is configured to allow ticket escalation only to Groupe 2

• Joe user can only reassign ticket to Groupe 2 because it’s assign to Groupe 1
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• For other users not assign to Groupe 1, they can’t reassign group to ticket (groups are not proposed
in the list of assignation)

• You can bypass this behavior per user
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7.5 Destek kaydının arama motoru

Uygulama eki üç yeni arama seçeneği ekler

• Düzey yükseltme ile ilgilenen grup

Ex : get all tickets actually escalated to group Groupe 1

• Düzey yükseltme sayısı
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Örnek: Düzeyi on kereden fazla yükseltilmiş tüm destek kayıtlarını alın

• İki grup arasındaki düzey yükseltme sayısı

Örnek : İki grup arasında 2 kereden fazla yükseltilmiş tüm destek kayıtlarını alın

7.6 Merkez sayfa

Kapatmak ve grubunuza atamak için çözümlenen destek kaydını görüntüleyen yeni pano bileşeni

Gruplarınızın güncel olarak atanmadığı ancak geçmişte atanmış olduğu çözümlenmemiş destek kayıtlarını görüntüle-
mek için yeni pano bileşeni

7.7 FAQ

If you have any questions about using the plugin, please consult our FAQ
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BÖLÜM 8

Fields

Alanlar uygulama eki destek kayıtları, bilgisayarlar, kullanıcılar gibi çeşitli GLPI ögelerine özel alanlar eklenebilmesini
sağlar.

Download Sources
https://github.com/pluginsGLPI/fields/releases https://github.com/pluginsGLPI/fields

8.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

8.2 Özellikler

• Çeşitli ögeler için kapsayıcı bloğu ekler,

• Bloklara alanlar ekler,

• Blokları var olan ya da yeni bir sekmede görüntüler,

• Pek çok farklı alan türü kullanılabilir,

• Alanlar zorunlu olarak işaretlenebilir,

• Herp kapsayıcı için profil Erişim Denetimi Listesi kullanılabilir,
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• . . .

8.3 Uygulama ekini kurmak

• Arşivi ayıklayın.

• fields klasörünü <GLPI_ROOT>/plugins klasörüne taşıyın

• Yapılandırma > Uygulama ekleri bölümüne gidin.

• Uygulama ekini kurup etkinleştirin.

8.4 Kullanım

Bu uygulama eki otomatik olarak veri tabanında gerekli tabloları ve diskte bazı dosyaları oluşturur (<GLPI_ROOT>/
files/_plugins/fields klasöründe). Bu dosyalar ve tablolar uygulama ekiyle birlikte güncellenir.

Uygulama ekinin kullanımı oldukça basittir:

• Bazı ögelere bağlı bir blok oluşturun,

• Bu blok içinde alanları oluşturun.

Uygulama eki yapılandırması için menüden Yapılandırma > Ek alanlar bölümüne gidin.

8.4.1 Yeni bir blok eklemek

• Etiket: Öge formlarında görüntülenecek blok etiketi,

• Tür: Görünüm türü, şunlardan biri:

– Sekme ekle: Bloğun bulunduğu öge formuna yeni bir sekme ekler,

– Form içine ekleme: Bloğu ana öge formunun sonuna ekler,

– Formdaki belirli bir sekmeye ekleme: Bloğu ögenin belirli bir sekmesine ekler.

• İlgili öge türü: Bloğun ekleneceği öge türlerinin listesi,

• Etkin: Bloğun etkin olup olmadığı.

Not: İlgili öge türü için Form içine ekleme türünde yalnız bir blok eklenebilir.

Blok belirli bir sekmeye blok yalnız bir öge için eklenebilir:
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Blok oluşturulduktan sonra, etiketi ya da etkin durumu değiştirilebilir ancak türü ya da ilgili ögeler listesi değiştirilemez.

Profiller

Bloğa erişebilecek profiller Profiller sekmesinden ayarlanabilir. Var olan her profil için Erişim yok, Okuma ya da Yazma
izni seçilebilir.
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8.4.2 Yeni bir alan eklemek

• Etiket: Öge formlarında görüntülenecek blok etiketi,

• Tür: Alan türü, şunlardan biri:

– Başlık: Görsel ayrım için kullanılan başlık etiketi,

– Metin (tek satır): Tek satırlık metin (input/@type="text"),

– Metin (birden çok satır): Çok satırlı metin (textarea),

– Sayı: Tek bir sayı (metin yazılamaz),

– Açılan kutu: Yapılandırılabilir bir açılan kutu. Kutudaki değerler, çekirdek GLPI üzerinde Yapılandırma >
*Açılan kutular bölümünden ayarlanabilir.

– Evet/Hayır: Yalnız Evet ve Hayır değerleri olan bir açılan kutu,

– Tarih: Tarih seçici bulunan bir tarih alanı,

– Tarih ve saat: Tarih seçici ve saat açılan kutusu olan tarih alanı (adım GLPI çekirdeğinden yapılandırılabi-
lir),

– Kullanıcılar: Kullanıcı listesi.

• Etkin: Bloğun etkin olup olmadığı.

• Salt okunur: Bu alanı salt okunur kılar,

• Varsayılan değerler: Alanın varsayılan değerleri,

• Zorunlu: Alanı zorunlu kılar.

Uyarı: Çeşitli ayarları değiştirirken dikkatli olmalısınız. . . Örneğin bir alanı hem zorunlu hem salt okunur olarak
işaretleyip varsayılan bir değer atamazsanız form doğrulamadan geçemez.

Başka bir örnek: Bir sayı alanına varsayılan değer olarak bir metin atayamazsınız. . . gibi :)

Alanlar oluşturulduktan sonra bloğun Alanlar sekmesinden sıralaması değiştirilebilir ya da düzenlenebilir:

48 Bölüm 8. Fields



GLPI plugins Documentation

Örneğin Kullanıcı ögesinde nasıl görüntüleneceği görülebilir:
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8.5 Arama

Eklenen tüm alanlar eklenmiş ögeler arama formlarından aranabilir.

8.6 Basit arayüz

Yalnız destek kayıtlarına eklenmiş ve Forma ekleme türündeki bloklar basit destek kaydı oluşturma arayüzünde görün-
tülenir. Geçerli profilin izinleri dikkate alınır!

8.7 Çeviriler

1.4.0 sürümünde geldi.

Uygulama eki Transifex <https://www.transifex.com/teclib/glpi-plugin-plugin-fields>`_; üzerinden çevrilebilir. Ayrıca
blok ve alanlar için etiket değerleri de çevrilebilir. İşlem ikisi için de aynıdır:

Blok formundaki Çeviriler sekmesine gidin:

Blok oluşturulurken geçerli dildeki yeni bir çeviri ve etiket değer kümesi oluşturulur; İstediğiniz kadar çeviri ekleyebi-
lirsiniz.

Açılan kutu değerleri çekirdek açılan kutu yapılandırması bölümünden yapılabilir.

Uyarı: GLPI 9.1.1 sürümüyle birlikte; Çekirdek üzerindeki bazı sorunlar açılan kutu uygulama eki değerlerinin
çevrilmesini engeller. Uygulama eki devre dışı bırakılabilir. Çekirdek sorunları giderildikten sonra yeniden etkin-
leştirilecek.
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8.8 Varlıklar

GLPI kopyanızda varlıkları kullanıyorsanız, bir blok yalnız, varlık uygulandığı uyumlu ögelerinden birine atanmış ise
görüntülenir.

Birden çok varlık kipinde bir blok ekler ya da düzenlerseniz, bloğun alt varlıklar için kullanılabilir olup olmadığını
belirtmeniz gerekir:

Örnek olarak, varlık yapımız şu şekilde olsun:

• kök

– A

∗ C

– B

Aşağıdaki tablo bloğun hangi durumlarda görüntülenip görüntülenmeyeceğini belirler:

Blok varlığı Aşağı inen blok Öge varlığı Blok görüntülenmesi
A Evet ya da Hayır A Evet
A Evet ya da Hayır B Hayır
A Evet C Evet
A Hayır C Hayır

8.9 FAQ

If you have any questions about using the plugin, please consult our FAQ
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BÖLÜM 9

Form oluşturucu

İndir Kaynaklar
https://github.com/pluginsGLPI/formcreator/releases https://github.com/pluginsGLPI/formcreator

FormCreator özel formların kolayca oluşturulabilmesini sağlayan bir uygulama ekidir.

9.1 Özellikler

• Ana menüden form yönetim ara yüzüne doğrudan erişim,

• Ana sayfalardaki formların vurgulanması,

• Formlara erişim denetimi: Herkese açık, belirli kullanıcı erişimi, bazı profiller için kısıtlı erişim,

• Basit ve uyarlanabilir formlar,

• Formları kategori, varlık ve dillere göre gruplayabilme,

• Her tür sunum için sorular: Metin alanları, listeler, LDAP, dosyalar gibi

• Bölümlere göre gruplanmış sorular. Görüntülenme sırasını seçebilme,

• Belirli bir ölçüte göre soru görüntüleme (önceki bir sorunun yanıtına göre),

• Formlardaki yanıtlara göre kesin denetim: Metin, rakam, alan boyutu, e-posta, zorunlu alanlar, kurallı ifadeler
gibi,

• Form yanıtlarından bir ya da bir kaç destek kaydı oluşturulması,

• Her alan, bölüm, form, varlık ya da dil için bir açıklama alanı eklenebilmesi,

• Destek kaydı kümesi biçimlendirebilme: Görüntülenen soruların yanıtları, destek kaydı kalıpları,

• Oluşturulan formu yapılandırma bölümünden ön izleyebilme,

• Form içeriklerini çeşitli dillerde sunabilmek için çevirebilme.
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Tüm değişikliklerin listesine uygulama eki kaynaklarından bakabilirsiniz <https://github.com/pluginsGLPI/
formcreator/blob/master/CHANGELOG.md>`_.

9.2 Uygulama ekini kurmak

• Arşivi ayıklayın.

• formcreator klasörünü <GLPI_ROOT>/plugins klasörüne taşıyın

• Yapılandırma > Uygulama ekleri bölümüne gidin.

• Uygulama ekini kurup etkinleştirin.

Uyarı: Uygulama ekinin klasörü uygulama eki ile aynı adı taşımalıdır:

• Doğru: glpi/plugins/formcreator

• Yanlış: glpi/plugins/formcreator-master

• Yanlış: glpi/plugins/formcreator-0.90-1.3.2

Bir uygulama ekinin dosyaları için GLPI plugins klasöründe yalnız bir klasör bulunmalıdır. Yedeklemek için bir
uygulama eki klasörünün adını değiştirmeyin, kopyalayıp silin!

9.3 Service catalog

The service catalog is a replacement for the GLPI’s simplified interface.

It is enabled on a per entity basis and exists in two flavors

• simplified

• extended

To enable it, edit an entity, open the Forms tab and set the field Helpdesk mode to Service catalog simplified or Service
catalog extended. This setting handles inheritance from parent entity to children entities.

Users using the simplified interface will benefit a new interface allowing them to:

• browse forms and FAQ with the unified interface

• follow the process of their requests

• book assets

• view their feeds

Users using the extended interface have a more complete view on their requests.

Forms with Direct access on homepage enabled will appear in the interface. Users may search by browsing the cate-
gories on the left of the screen, and may also search for forms with a natural language search engine.

By default FAQ items in the Knowledge Base also show with forms. The only prerequisite is to associate form categories
to knowledge base categories (in Setup > Dropdowns : Forms > Form categories).
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It is possible th have a distinct display of FAQ in Administration > Entities > Forms. When Distinct menu entry is
selected the service catalog shows a new menu entry on the left. FAQ are browsable by category and key words.

Not: All entity settings for Formcreator propagate to sub entities by default. The administrator may change the settings
in a sub entities to break inheritance.

9.3.1 Overview

The service catalog shows several counters on the top left corner. Those counters show all requests involving the current
user as a author, requester, observer, assigned or validator.

The requests displayed here are

• tickets created without Formcreator

• tickets generated by forms havung only one target tickets

• form answers when the form has no target ticket

• form answers when the form has several target tickets

The request are spread over 4 counters

• processing

• pending

• to validate

• closed

Not: New requests are not included in the counters.

9.3.2 RSS feeds

When users are allowed to view RSS feds, the service catalog shows a menu entry on the left to access them. RSS feeds
administration is done in GLPI as usual.

9.3.3 Reservations

Users may book an asset with GLPI’s reservation system, avaialble in the left menu of the service catalog.
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9.4 Form yapılandırmaları

9.4.1 Form oluşturmak

Not: GLPI üzerinde varlıkları güncelleme hakkına sahip profillere form oluşturma izni verilir. Bu iznin nasıl kurula-
cağını öğrenmek için GLPI belgelerine bakın.

Not: Formlar, bulunmaları amaçlanan birimlerde oluşturulmalıdır. Alt birimler alanı Evet olarak ayarlanmışsa, bir
form kendi biriminde ve tüm alt birimlerinde kullanılabilir.

1. Yönetim > Formlar bölümüne gidin.

1. Bir form eklemek için + düğmesine tıklayın

Şu alanlar doldurulmalıdır:

• Ad: Formun adı.

• Etkin: Bir form varsayılan olarak etkin değildir. Kullanıma hazır olduğunda etkinleştirmeniz gerekir.

Kategori alanını doldurmanız önerilir:

• Basitleştirilmiş arayüzde, kategoriler formların bloklara göre düzenlenmesini sağlar.

• Hizmet kataloğunu kullanmak istiyorsanız, form kategorilerini kullanmanız gerekir.

Not: Form kategorileri, uygulama ekinin açılır listeleridir. Kategori alanının yanındaki + öğesini kullanarak bir formu
düzenlerken doğrudan form kategorileri ekleyebilirsiniz. Bu işlemi Yapılandırma > Açılan kutu > Form kategorileri’
bölümünden de yapabilirsiniz.

• Ana sayfadan doğrudan erişim: Basitleştirilmiş GLPI arayüzünden forma doğrudan erişim sağlar.

• Description: displays in the list forms.

• Language: by default a form is set to the language of its creator. The form will be available only to users using
the same language as the form. Choose All languages to make the form available to users without language
restriction.
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• Başlık: Form görüntülendiğinde görüntülenir.

• Need to be validate: If Yes a list of validators is displayed. This is a list of GLPI users (with the right Validate an
incident or Validate a request (in its profile) on a compatible entity with the form’s entity. The list of validators
is a multiple choice list. If no validator is selected all of them are submitted when the form is being used.

• Hizmet kataloğunun varsayılan formu: Evet ise form, geçerli kategori veya anahtar sözcüklere göre süzülme-
den hizmet kataloğunda görüntülenir.

When all fields are filled, click on the add button at the bottom of the page.

Not: Deleting a form is possible only if there are no associated answers. To delete a form, delete all its answers first
from the Form answers tab.

9.4.2 Bölümler

Soru sekmesine tıkladıktan sonra aşağıdaki sayfa görüntülenir:

Önce bir bölüm oluşturmalısınız. Bölümler, formdaki soruları gruplamak için kullanılır.

Formun diğer bölümlerinde yer alan sorulara verilen yanıtlara göre bölümün görüntülenmesini ya da gizlenmesini
sağlaycak koşullar oluşturulabilir.

9.4.3 Sorular

İstediğiniz bir bölümde Bir soru ekle üzerine tıklayın.

Şu sayfa görüntülenir:
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A question is made of:

• a title: this is the label of the question in the form.

• a type: see list below.

• a section: the section containing the question. You can move a question to an other section with this field.

• a description: it is displayed under the question in the form. Use it as a hint for the requester, telling him which
content is expected.

• a dropdown list Show field to enable a condition

It submits the following choices:

• Always visible: the field is always displays

• Hidden unless: The question is hidden except if answers to other questions matches a condition.

• Displayed unless: The question is displayed except if the answers to other questions matches a condition.

Koşullar birden fazla olabilir. Bir koşul eklemek ya da kaldırmak için iki düğme bulunur:
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Not: Simge listesi

• Çember bir sorunun zorunlu kılınmasını ya da

, or optional

• Arrow up and arrow down allow you to reorder questions in a section.

• Bir soru üzerine tıklanarak düzenlenebilir.

• Üst üste iki kare bir soru ya da bölümün kopyasını oluşturur.

• Çöp kutusu bir soru ya da bölümü siler.

Questions are organized on a 4 columns array. You can resize width of questions, reorder them using drag and drop and
put up to 4 questions on the same row.

9.4.4 Soru türleri

There are about twenty types of questions available. Depending on the chosen type, you need to provide additional
information.

Not:

• Zorunlu: Evet/Hayır. Formu çalıştırırken, yanıtlanması zorunlu olan soruların etiketinin yanında kırmızı bir
yıldız görüntülenir.

• Varsayılan değerler: İçeriği, sorunun türüne bağlıdır.

• Range Min/Max: Restricts the value to the given range when running the form.

• Additional validation (Regular expression): You may set a custom regex with a regular expression. Use it when
other restriction methods cannot satisfy your needs. Don’t forget to specify the delimiters of the regex. You may
add any modifier after the closing delimiter.
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Aktörler

Bu alan ile, bir veya birkaç kullanıcı seçebilirsiniz:

• GLPI içinden Yönetim > Kullanıcılar bölümündeki kullanıcılar seçilebilir

• GLPI dışından e-posta adresi yazabilirsiniz

İşaret kutuları (çoklu seçim)

Değerler bölümünde her değer için bir satır ekleyin. Varsayılan değerler, her satıra bir tane olacak şekilde Varsayılan
değerler bölümünden ayarlanabilir. Bu alan boş bırakıldığında hiçbir kutu işaretlenmez.
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Tarih / Tarih saat / Saat

Bu alan mini takvimden bir tarih, tarih saat veya saat seçilebilmesini sağlar.

Açıklama

This field only displays information. Use it to give more details about a question.

Açılan kutu

Bu alan, kullanıcının GLPI içindeki bir açılır menüde (Yapılandırma > Açılan kutular) bulunan kutular arasından
bir değer seçmesini sağlar.
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E-posta

The answer to this type of field must be a syntactically valid email address.

Dosya

Bu alan, istekte bulunan kişinin bir dosya yükleyebilmesini sağlar.

Ondalık

This field must be a float value. Note you may use a regular expression to tighter restrict the answer.

GLPI nesnesi

This field allows you to build a dropdown from a GLPI object among those available in the menus:

• Varlıklar

• Destek

• Yönetim

• Araçlar

• Yönetim
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Gizli alan

Bu alan gizlidir ve hedef (destek kaydı ya da değişiklik) oluşturulurken rastgele bir değer alınmasını sağlar.

Not: This type of questions never shows on a form.

Sunucu adı

This field is invisible. It allows to get the hostname of the computer used by the requester, assuming the DNS is able to
properly resolve it from its IP address

Tamsayı

Bu alanın yanıtı bir tamsayı değeri olmalıdır. Yanıtı daha sıkı kısıtlamak için bir kurallı ifade kullanabileceğinizi unut-
mayın.

IP adresi

This field is hidden and collects the IP address of the form requester. It does not show in the form.

LDAP seçimi

Bu alan, bir LDAP dizinindeki nesnelerin bulunduğu bir açılan kutu oluşturmanızı sağlar:

Not: This type of questions cannot be used to fill actors of a target.
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Çoklu seçim (birden çok seçenek)

This field allows you to create a dropdown list with ability to select multiple items. Values are added one per line in the
field Values. You may set default values, one per line in Default values*. If no default value is set then no item will be
selected by default.

Request type

This field is a dropdown with “Incident” or “Request” choices. It can be used to set the request type of a ticket being
generated by the form.

Radyo düğmeleri (yalnız bir seçenek)

Değerler bölümünde her değer için bir satır ekleyin. Varsayılan değer, Varsayılan değer bölümünden ayarlanabilir. Bu
alan boş bırakıldığında baştan hiçbir seçenek işaretlenmez.
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Seçim (yalnız bir seçenek)

Bu alan, bir açılır kutu oluşturmanızı ve kutuda görüntülenecek ögeleri ayarlamanızı sağlar. Ögeler, Değerler bölümün-
den her biri ayrı satırda olacak şekilde eklenir. Varsayılan değer Varsayılan değer bölümünden ayarlanabilir. Varsayılan
değer ayarlanmadığında, baştan varsayılan bir öge seçilmez.

Etiketler

This is a hidden field to add a tag to the form for future processing.

Not: Bu alan türü yalnız Etiket uygulama eki kurulu ve etkinleştirilmiş ise kullanılabilir.

Metin

Bu alan, tek bir metin satırı yazılmasını sağlar.

Metin alanı

Bu alan, bir kaç satırlık metin yazılmasını sağlar.

Önem derecesi

Bu alan, GLPI içinde tanımlanmış bir önem derecesini seçmenizi sağlar.

9.4.5 Conditions

Conditions are expressions involving questions and sections which are evaluated in order to determine

• if a question is displayed

• if a section is displayed

• if the submit button of a form is displayed

• if a target (see below) must be generated

Available operators in an assertion are:

• equals

• not equals

• less than

• greater than

• less than or equal

• greater than or equal

• is visible

• is not visible

• matches a regular expression
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The condition expression can be used with the following rules:

• Hidden unless: the item is hidden or not generated except when the expression is true

• Displayed unless: the item is displayed or generated except when the expression is true

9.4.6 Erişim türleri

Üç değer kullanılabilir:

• Herkese açık erişim: Anonim kullanıcılar forma erişebilir. Bir Intranet sitesinde kullanabilirsiniz.

• Özel erişim: Yalnız GLPI hesabı olan kullanıcılar forma erişebilir.

• Sınırlı erişim: Yalnız belirtilen profillerdeki kullanıcılar forma erişebilir.

When a form is set to Public access it is possible to enable a simple captcha. This captcha should prevent spamming if
a form is accessible from internet.

Not: Captchas are not enabled by default on anonymous forms. Administrators need to enabled them explicitly depen-
ding on how the form may be accessible from an hostile network such Internet.

9.4.7 Hedefler

There are three types of targets for a form:

• Destek kayıtları

• Değişiklikler

• problems

Tek bir formdan herhangi bir sayıda hedef oluşturulabilir. Hedef türleri karıştırılabilir.

Bir hedef oluşturmak için Bir hedef ekle üzerine tıklayın

Ardından aşağıdaki pencere görüntülenir:
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Bir hedef adı seçin ve yazın, ardından doğrulayın. Yeni hedef oluşturulur ve ayarları yapılabilir.

9.4.8 Ön izleme

Bu sekmede, formun nasıl görüntüleneceğine bakabilir ve etkinleştirmeden önce deneyebilirsiniz.

Not: Ön izlemeden gönderilen yanıtlar gerçekten kaydedilir ve form doğrulanacak şekilde yapılandırılmamışsa hedefler
oluşturulur.

9.4.9 Form yanıtları

Bu sekmede, formun kaydedilen tüm yanıtları görüntülenir.

Not: Bir formu silmek için önce tüm yanıtlarının silinmesi gerekir. Bir anımsatıcı olarak bir formun ana sekmesinin
altında bir uyarı görüntülenir.

9.4.10 Kategoriler

Menu : Ayarlar > Açılan kutular : Formlar > Form kategorileri

Form kategorileri, form listenizi düzenlemenizi sağlar. Formlar, seçilen kategoriye ya da herhangi bir alt kategoriye ait
olduklarında görüntülenir. Herhangi bir kategorisi olmayan bir form, yalnız herhangi bir kategori seçilmediğinde ya da
kullanıcı “tümünü görüntüle” seçeneğini seçtiğinde görüntülenir.

Kategoriler genel olarak Ayarlar > Açılan Kutular menüsünden eklenip düzenlenebilir.

Ayrıca yeni kategoriler, tüm diğer GLPI açılan kutuları gibi doğrudan form sayfasından eklenebilir.

Varlıklara göre tanımlanırlar ve GLPI 0.85 sürümünden itibaren tüm diğer açılan kutular gibi başka dillere çevrilebi-
lirler.

Not: Genel GLPI yapılandırması sayfasından açılan kutu çevirileri etkinleştirilmiş olmalıdır: Yapılandırma > Genel
> Genel Yapılandırma > Açılan Kutu Çevirileri = Evet

Not: Kategoriler Bilgi Bankası Kategorileri ile ilişkilendirilebilir. Formların yanında yazılan konuya göre SSS kayıt-
larının görüntülenmesi için bu bağlantı gereklidir.
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Yapılandırma

Görünüm oluşturma
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9.4.11 Sorular

After the creation of a form, create fields for the user to fill out.

The name of the questions will appear on the left and the field type selected on the right.

Açıklama doldurulacak alanın altında bulunur.

Additional options may be displayed depending on the currently selected question type.

Girişin doğrulanmasını isteniyorsa, PHP kurallı ifadeleri kullanılabilir.

Soruların, diğer sorulara verilen yanıtlara göregörüntülenmesini istiyorsanız bir soruyu düzenlerken alanlar görüntü-
lensin bölümünü kullanın. 2.5.0 sürümünde bir kaç sorunun içeriğini denetlemek için karmaşık ifadeleri ile VEYA ve
VE* mantık işlemleri kullanılabilir. VE işleminin VEYA işlemine göre önceliği vardır.

9.4.12 Translation

In some cases a form should be available in several languages. Choose first in which language a form should be created.
This language should be english (US or UK) or the language that most of target users understand. This is the fallback
language if no alternative is found.

This language is also used as reference in the translation process. Then be sure that the chosen language is readable by
the user who will translate the form.

To translate a form open the tab Form languages, then create all languages you need to provide to users.
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Choose a language added to the form and click it to begin or resume translation, then select the tab Translations. Click
the button New translation and a popup dialog will open and show a string to translate. Type the translation, and click
save or validate with Enter on your keyboard.

If another string must be translated, it will show immediately. If no more string needs to be translated, a message will
show instead.
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When you close the dialog the list of translated strings is refreshed. You can edit a translation by clicking on it, delete
one or several translations with the checkboxes on the left of the list and the Delete button**. You can also filter the
list with the filter input box.

9.5 Hedefler

Hedefler FormCreator üzerinden yapılan gönderimlerde oluşturulan nesnelerdir. Bir formun doğrulanması gerekiyorsa,
hedefler onay alınana kadar geciktirilir.

Not: Hedefler şu anda yalnız destek kayıtları olabilir.

Bir hedef destek kaydı form tarafından oluşturulan destek kaydını belirtir. Bir formun bir kaç hedefi olabilir.

Hedef sekmesini açın ve bir ad ve tür seçerek bir hedef oluşturun (yalnız geçerli destek kaydı için).
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9.5.1 Hedef destek kaydı

Bir destek kaydı oluşturan bir hedef destek kaydı.

Destek kaydı, sıfırdan ya da GLPI üzerinde bulunan bir destek kaydı kalıbından oluşturulur. Şunları yapabilirsiniz:

• Diğer olası hedeflerden ayırt etmek için hedef destek kaydının adını özelleştirebilirsiniz,

• Soruları ve yanıtları kullanarak destek kaydının başlığını ve açıklamasını özelleştirebilirsiniz,

• Oluşturulan destek kaydının hedef birimini ayarlayabilirsiniz,

• Bir çözümlenme süresi ayarlayabilirsiniz (önceki adıyla bitiş tarihi),

• Destek kaydının türünü ayarlayabilirsiniz (istek ya da sorun olarak),

• İlişkili bileşenleri ayarlayabilirsiniz,

• Kategoriyi ayarlayabilirsiniz,

• Önem derecesini ayarlayabilirsiniz,

• Konumu ayarlayabilirsiniz,

• Tags uygulama eki kullanılabiliyorsa destek kaydına etiketler atayabilirsiniz,

• Oluşturulan destek kaydını başka destek kayıtları ile ilişkilendirebilirsiniz,

• Destek kaydının aktörlerini belirleyebilirsiniz,

• Hedef destek kaydını oluşturmak için karşılanması gereken ölçütleri belirleyebilirsiniz.

Not: Önem derecesi, kategori ya da konum (belirli ya da bir sorudan) ayarlamak, bilet kalıbında (varsa) tanımlanan
önem derecesini değiştirir
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Hedef birim

Kullanılabilecek pek çok seçenek var:

• Geçerli etkin birim: Formu doldurarak istekte bulunan kişinin birimi,

• Varsayılan istekte bulunanın birimi: Formu doldurarak istekte bulunan kullanıcının varsayılan birimi,

• İlk devingen istekte bulunan kişinin birimi (alfabetik): İstekte bulunan kişinin tüm devingen birimlerini alfabetik
olarak sıralar ve ilkini seçer,

• Son devingen istekte bulunan kişinin birimi (alfabetik): İstekte bulunan kişinin tüm devingen birimlerini alfabetik
olarak sıralar ve sonuncusunu seçer,

• Formun birimi: İstekte bulunan kişi tarafından doldurulan formun bulunduğu birim,

• Doğrulayıcının varsayılan birimi: İsteği doğrulayan kişinin varsayılan birimi,

• Belirli birim: Formun tasarımcısı tarafından ayarlanan bir birim,

• Bir kullanıcı türü soru yanıtının varsayılan birimi: Bir soruda istekte bulunan kişi tarafından seçilen bir kullanı-
cının varsayılan birimi.

• Bir GLPI nesnesinden > Birim türü sorusunun yanıtı: İstekte bulunan kişi tarafından bir sorudan seçilen birim.

Not: İstekte bulunan kişinin varsayılan birimi ayarlanmamış olabilir. Bu durumda destek kayıtlarının kök birimde
oluşturulma riski vardır.

Not: Doğrulayan kişinin varsayılan birimi ayarlanmamış olabilir. Bu durumda destek kayıtlarının kök birimde oluştu-
rulma riski vardır.

Not: Devingen istekte bulunan kişinin birimi. Kullanıcı eşitlemesi gerekir. Bu durumda destek kayıtlarının kök birimde
oluşturulma riski vardır.

Destek kaydı kalıbı

Bir kalıptan destek kaydı oluşturmak için hazır ayarları belirler. Hedef destek kaydında belirlenen tüm ayarlar, kalıpta
bulunan değerleri değiştirir.

İstek türü

Oluşturulan destek kaydının türünü ayarlar

• Varsayılan ya da bir kalıptan: Herhangi bir tür ayarlanmadığında GLPI tarafından ya da varsa bir kalıptan ve
ayarlanmışsa bu kalıptaki tür değerinden

• Belirli tür: İstek ya da sorun,

• Sorunun yanıtına eşittir: Değer, bir istek türü sorusundan ayarlanır.
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İlişkili bileşenler

Oluşturulan destek kaydının ilişkili bileşenlerini ayarlar

Yok : Açıklamak gerekmez, Belirli varlık: Formun tasarımcısı tarafından ayarlanan bir varlık, Bir sorunun yanıtına
eşittir: İstekte bulunan kişi tarafından, bir sorudan ayarlanan bir varlık Son geçerli yanıt: İstekte bulunan kişi tarafından
ayarlanan bir varlık. Bu amaç için uygun olan son görünür sorudan

Kategori

Oluşturulan destek kaydının kategorisini ayarlar

• Kalıptan kategori ya da yok: Varsa ve bu kalıbın hazır bir kategorisi varsa bir kalıptan kategoriyi ayarlar. Diğer
tüm durumlarda yok,

• Belirli kategori: Formun tasarımcısı tarafından ayarlanan bir kategori,

• Bir sorunun yanıtına eşittir: İstekte bulunan kişi tarafından seçilen bir kategori,

• Son geçerli yanıt: Kategori türünde görüntülenen son sorudan bir kategori,

Önem derecesi

• Kalıptan önem derecesi ya da yok: Varsa ve bu kalıbın hazır bir önem derecesi varsa bir kalıptan önem derecesini
ayarlar. Diğer tüm durumlarda yok,

• Belirli önem derecesi: Formun tasarımcısı tarafından ayarlanan bir önem derecesi,

• Bir sorunun yanıtına eşittir: İstekte bulunan kişi tarafından seçilen bir kategori,

Konum

• Kalıptan konum ya da yok: Varsa ve bu kalıbın hazır bir konum varsa bir kalıptan konumu ayarlar. Diğer tüm
durumlarda yok,

• Belirli konum: Formun tasarımcısı tarafından ayarlanan bir konum,

• Bir sorunun yanıtına eşittir: İstekte bulunan kişi tarafından seçilen bir kategori,

Hedefi görüntüleyecek koşul

Form tasarımcısı, koşullara bağlı olarak destek kaydının oluşturulmasını kısıtlayabilir.

9.5.2 Hedef değişikliği

Bir değişiklik oluşturan bir hedef değişikliği
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Değişiklik sıfırdan oluşturulur. Şunları yapabilirsiniz:

• Soru ve yanıtları kullanarak başlık, açıklama, etki, kontrol listesi, dağıtım yolu, yedekleme planı ve kontrol listesi
alanlarını özelleştirebilirsiniz,

• Bir değerden ya da bir sorudan önem derecesini ayarlayabilirsiniz,

• Birkaç ilke arasından değişikliğin birimini seçebilirsiniz,

• Çözümlenme zamanını ayarlayabilirsiniz,

• Değişiklik aktörlerini belirleyebilirsiniz,

• Değişiklik kategorisini ayarlayabilirsiniz.

• Hedef destek kaydını oluşturmak için karşılanması gereken ölçütleri belirleyebilirsiniz.

9.5.3 Target description templating

Target ticket and target change both have description template. By default the template uses the tag ##FULLFORM##.
This tag is a default template where all questions and sections are displayed in the same order as the form.

Each question has 2 tags

• ##question_x## which is replaced by the label of the question. X is the ID of the question.

• ##answer_x## which is replaced by the answer to a question. X is the ID of the matching question.

Questions of type dropdown support more complex expression like ##answer_x.name##. x still means the ID of a
question. the word after the dot is the name of a property available in the search options of the itemtype of the dropdown
question.

As an example, consider a dropdown question which shows locations. The itemtype set by the form designer is “Loca-
tion”. The designer can render in the target many fields of the location selected by the requester, such address, postcode,
state, building, and many other data. To find them, the admin may rely on the list available in the search filters for a
location.
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9.6 Issues lifecycle

9.6.1 Abstract

The service catalog relies mostly on a list of issues (or assitance request). Issues are created and maintained upon events
related to tickets and form answers.

When a ticket is created from GLPI, then a new issue is created in the database. When this ticket is being updated, the
issue is updated to reflect all relevant changes.

Form answers are created when a requester fills a form and submits it. When a form answer is created a new issue is
created as well. As a form answer may or may not trigger the creation of tickets, issues behave differently depending
on this quantity of generated tickets.

9.6.2 Ticket created from GLPI

When a ticket is created from GLPI, the issue reflects most useful information from this ticket.

9.6.3 Form answer without any generated ticket

When a form answer did not generate a ticket, or when the form answer generating tickets is waiting for validation, then
the issue reflects the form answer.

9.6.4 Form answer with a single generated ticket

When a form answer trigered the creation of one and only one ticket, then the issue reflects this ticket. This is also true
when the approval of a form answer triggers the creation of a single ticket.

9.6.5 Form answer with several generated tickets

When a form answer generated several tickets, then the issue reflects a list of those tickets. Each ticket is viewable by
the requester, if he is granted to view it.

9.6.6 Status

Computation of status

Issues follow the lifecycle of tickets or form answers, depending on which object it reflects.

When an issue reflects a single ticket, its status takes into account the validation status of a ticket, if any. The validation
status of the ticket takes precedence when the ticket is not solved and waiting for approval or has been refused. For all
other cases, the issue shows the regular ticket status.

You may refer to the following table to have a quick view of how the status is computed:
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Validation Status
NONE WAITING REFUSED ACCEPTED

Ticket
Status

INCOMING T V V T
ASSIGNED T V V T
PLANNED T V V T
WAITING T V V T
SOLVED T T T T
CLOSED T T T T

• T = status picked from Ticket

• V = status picked from Validation

When an issue reflects several tickets then the status of each ticket is computed from the above description, and the least
advanced status is used. If an issue reflects 3 tickets having statuses Waiting, Resolved and Closed, then the choosen
status is Waiting. This means that an issue is closed oly when all its tickets are closed.

searching issues by status

The search engine shows many statuses. Some are shortcuts to search several statuses at once, like tickets, some are
specific to the statuses of form answers.

• new: new issues

• processing (assigned): processing issues

• processing (planned): planned issues

• waiting: issues waiting for information from requester or waiting for validation by a valdiator

• solved: issues solved or refused by a validator

• closed: issues closed or accepted by a validator (this happens when no ticket has been generated after validation)

• not solved: all statuses but solved or closed

• not closed: all statuses but closed

• solved + closed: issues solved or closed

• all: any status

• accepted: issues accepted by a validator

• refused: isses refused by a validator

•
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9.7 Exporting and importing forms

9.7.1 Abstract

Formcreator allows exporting and importing forms between instances of GLPI.

This feature is designed to let administrators develop forms on a testing environment and copy them on a production
environment.

When a form is being imported the plugin searches for a matchng form in the database. This is done with the help of
a random identifier created when a new form is instanciated. Each sub object (sections, questions, conditions, targets)
also have a random identifier. This helps the plugin to find a matching item and update it if necessary. Thanks to this
mechanism Formcreator is able to update a form when it is imported more than once.

9.7.2 Limitations

A form may contain relations to objects of GLPI itself (mostly users, groups, categories, entities). There is currently no
reliable way to maintain relations between forms and GLPI’s objects or assets accross instances. It is therefore highly
recommended to develop forms on a testing environemnt with a reasonably recent copy of the production database.

The export / import feature does not support importing forms accros different versions of Formcreator. The version
2.10 shows a warning if it detects a attempt of importing forms from a previous version. In version 2.11 such imports
are not allowed.

9.7.3 Exporting forms

1. Navigate to Administration > Forms

2. Use massive actions to export one or more forms. Clicking on the Post button will start the download of a JSON
formated file. This file contains all forms selected for the export.
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9.7.4 Importing forms

1. Navigate to Administration > Forms

2. Use the toolbar to import forms.

3. Select one or more JSON files created with the same version of Formcreator and validate.

1. Depending on the complexity and the quantity of forms the process may be slow. Please be patient.

2. Carefully check the messages when the import completes. You may get warnings and errors.
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9.7.5 Import behavior

Entities

When Formcreator imports a form, it checks that the entity of the form exists and the user has right to update entities.
If not, the form is ignored and trigger a warning.

Form categories

Form categories are created if they don’t exist yet.

Users and groups

The users and groups found in target actors must exist. If not, the import of the form will stop with an error, leading to
an incomplete form. Other forms will be imported.
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BÖLÜM 10

Genel nesne

Download Sources
https://github.com/pluginsGLPI/genericobject/releases https://github.com/pluginsGLPI/genericobject

10.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

10.2 Özellikler

Bu uygulama eki GLPI yapısına bütünleşik yeni envanter nesneleri eklenebilmesini sağlar.

Şu GLPI özelliklerini destekler:

• Varlık ve alt varlık yönetimi,

• Arama,

• Kalıplar,

• Geçmiş,

• Destek merkezi bütünleştirmesi,

• CSV dosya ekleme uygulama eki bütünleştirmesi,
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• Öge kaldırma uygulama eki bütünleştirmesi,

• Sipariş yönetimi uygulama eki bütünleştirmesi.

10.3 Kullanım örneği

Amaç: Araç filonuzu BT varlıklarınız gibi yönetmek.

• Araçlar adında yeni bir envanter nesnesi ekleyin.

• Araçlar için kullanılacak alanları ekleyin: ad, seri numarası, stok kodu, tür, model, renk, durum, gibi.

• Bir aracın davranışını belirtin: Alt birimde görüntülensin, geçmişi kaydedilsin gibi.

• Araçlar üzerindeki izinleri ayarlayın.

• Araçlar nesnesini etkinleştirin.

• Araç filonuzu GLPI üzerinden yönetin.

10.4 Uygulama ekini kurmak

• Arşivi ayıklayın.

• genericobject klasörünü <GLPI_ROOT>/plugins klasörüne taşıyın

• Yapılandırma > Uygulama ekleri bölümüne gidin

• Uygulama ekini kurup etkinleştirin.

10.5 Kullanım

10.5.1 Yeni bir nesne türü ekleyin

Bu ilk adımdır.

• Uygulama eki yapılandırması formunda + düğmesine tıklayın.

• Yeni envanter nesnesi türü oluşturun:

– Ad: Zorunludur, küçük harflerle ve yalnız şu karakterler kullanılarak yazılmalıdır:

– Etiket: Varsayılan olarak ad ile aynıdır.

• Doğrulayın.

• Kullanabilmek için yeni öge türünü etkinleştirin.

Örnek: Yeni Araç envanter nesnesini oluşturun.
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10.5.2 Etiketleri düzenleyin

Her tür için <GLPI_ROOT>/files/_plugins/genericobject/locales/itemtype/ altında bir dil dosyası bulunur

Bu uygulama eki şunları oluşturur:

• Geçerli dil için bir dil dosyası

• Varsayılan GLPI dili için bir dil dosyası

Not: Geçerli ve varsayılan dil aynı ise yalnız bir dosya oluşturulur.

İngilizce dilinde öge türünün etiketini değiştirmek için şu dosyayı düzenleyin:

<?php
// <GLPI_ROOT>/files/_plugins/genericobject/locales/<itemtype>/<itemtype>.en_GB.php
$LANG['genericobject']['<itemtype>'][1] = "<type's label>";

You can also define labels globally in <GLPI_ROOT>/files/_plugins/genericobject/locales/fields.
<lang>.php files:

<?php
// <GLPI_ROOT>/files/_plugins/genericobject/locales/<itemtype>/<itemtype>.en_GB.php
$LANG['genericobject']['fields']['<itemtype>'] = "<type's label>";

10.5.3 Kurulum davranışı

Örnek: Bir aracın davranışını belirtin: Alt varlıkta görüntülensin, geçmişi kaydedilsin gibi.

Yeni tür normal GLPI türleri (bilgisayar, ekran, ağ aygıtı vb) ile aynı şekilde yönetilir

Not: Tüm nesneler için atanmış en az bir birim olmalıdır

Davranış sekmesinde şunlar tanımlanabilir:

• Alt kayıtlar: Türün alta doğru genişletilmesini sağlar;

• Destek masası: Bir nesnenin bir çağrı kaydı ile ilişkilendirilmesini sağlar:

• Çöp: GLPI çöp kutusu özelliğini kullanır;

• Notlar: GLPI not özelliğini kullanır;

• Geçmiş: Bu türün geçmişini kaydeder;

• Kalıplar: Kalıpların yönetimini sağlar;

• Belgeler: Bu türdeki nesnelere belge eklenebilmesini sağlar;

• Ödünç verme: Nesnelerin ödünç verilebilmesini sağlar;

• Sözleşmeler: Bir nesneyi bir ya da bir kaç kişi ile ilişkilendirir;

• Ağ bağlantıları: Bu tür için yönetim ve bağlantı noktalarının kullanılabilmesini sağlar;

• CSV file injection uygulama eki: Bu türün şu uygulama ekiyle kullanılabilmesini sağlar;

• Item uninstallation uygulama eki: Bu türün kaldırılmasını sağlar;
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• Sipariş yönetimi uygulama eki: Bu türün bir sipariş ile ilişkilendirilmesini sağlar;

10.5.4 Alanlar ekleyin

Örnek: Araçlar için kullanılacak alanları ekleyin: ad, seri numarası, stok kodu, tür, model, renk, durum, gibi.

Alanlar sekmesine gidin.

Bu uygulama eki ile kullanılmaya hazır bazı alanlar gelir:

• Ad

• Tür

• Model

• Seri numarası

• Stok numarası

• Ögenin kullanıcısı

• Grup

• Durum

• Yorumlar

• Notlar

• Konum

• Diğer

• Üretici

• İnternet adresi

• Eklenme tarihi

• Son kullanma tarihi

• Kategori

• Destek merkezinde görüntülensin

• Donanımdan sorumlu kişi

• Etki alanı

• İlgili

• İlgilinin telefonu

Not: Bazı davranışlar kullanıldığında nesneye bazı alanlar otomatik olarak eklenir:

• Ağ bağlantısı => konum

• Ödünç verme => konum

• Destek merkezi => destek merkezinde görüntülensin

• Notlar => notepad
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Destek merkezi bütünleştirmesi

Bir nesneyi destek merkezinde kullanmak için şu ayarları kullanın:

• Davranış sekmesinde: Destek merkezi kullanılsın seçeneği Evet olarak ayarlanmalıdır.

• Kullanıcı alanı belirtilmiş ise öge Ögelerim listesinde görüntülenir (ögenin sahibi bu kullanıcı olarak).

• Grup alanı belirtilmiş ise öge gene Ögelerim listesinde görüntülenir (öge kullanıcının bulunduğu gruba ait oldu-
ğundan).

• Destek merkezinde görüntülensin alanı ayarlanmış ve değeri Hayır ise nesne destek merkezinde görüntülenmez.

10.5.5 Yeni alanlar eklemek

Not: Bu seçenek etkinleştirildiğinde, yeni alanlar tüm nesne türleri için kullanılabilir.

• <GLPI_ROOT>/files/_plugins/genericobject/fields/<type>.constant.php adında yeni bir dosya
oluşturun

Örneğin arac türü için sabit dosyası <GLPI_ROOT>/files/_plugins/genericobject/fields/arac.constant.
php şeklinde olur.

Lütfen dosyanın ilk satırının şu şekilde olduğundan emin olun. Yoksa yeni alanlar listede görüntülenmez:

<?php
global $GO_FIELDS, $LANG;

• Yeni alan tanımlarını ekleyin.

10.5.6 Basit açılan kutu alanı eklemek

<?php
$GO_FIELDS['plugin_genericobject_mytypecolors_id']['name'] = $LANG['genericobject
→˓']["<type's name>"][2];
$GO_FIELDS['plugin_genericobject_mytypecolors_id']['field'] = 'color';
$GO_FIELDS['plugin_genericobject_mytypecolors_id']['input_type'] = 'dropdown';

Not: Dil dosyasında dil değişkeni tanımlanmalıdır (yukarıdaki açıklamaya bakın).

• Bir varlığa atanmış bir açılan kutu alanı eklemek:

<?php
$GO_FIELDS['plugin_genericobject_mytypecolors_id']['name'] = $LANG['genericobject
→˓']["<type's name>"][2];
$GO_FIELDS['plugin_genericobject_mytypecolors_id']['field'] = 'color';
$GO_FIELDS['plugin_genericobject_mytypecolors_id']['input_type'] = 'dropdown';
//Does the dropdown take care of entities ? (true/false)
$GO_FIELDS['plugin_genericobject_mytypecolors_id']['entities_id'] = true;
//Can values be recursive ? (true/false, only taking in account if entities_id is set to␣
→˓true)
$GO_FIELDS['plugin_genericobject_mytypecolors_id']['is_recursive'] = true;
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10.5.7 Bir açılan ağaç alanı eklemek

<?php
$GO_FIELDS['plugin_genericobject_mytypecolors_id']['name'] = $LANG['genericobject
→˓']["<type's name>"][2];
$GO_FIELDS['plugin_genericobject_mytypecolors_id']['field'] = 'color';
$GO_FIELDS['plugin_genericobject_mytypecolors_id']['input_type'] = 'dropdown';
//Is it a tree-dropdown, or a simple one ? (true/false)
$GO_FIELDS['plugin_genericobject_mytypecolors_id']['is_tree'] = true;

Not: Aynı zamanda şu parametreleri de kullanabilirsiniz: entities_id, is_recursive, is_tree.

10.5.8 GLPI çekirdek nesnesi temelli bir açılan kutu alanı eklemek (kullanıcı, ko-
num. . . ):

<?php
$GO_FIELDS['users_id_passengers_id']['name'] = 'Passenger';
$GO_FIELDS['users_id_passengers_id']['input_type'] = 'dropdown';

Not: Köşeli parantez içindeki adlar ([]) GLPI kullanıcı listesinde bir alan olarak değerlendirilmesi için users_id ile
BAŞLAMALIDIR.

Kullanılabilecek alanların tam listesini <GLPI_ROOT>/files/_plugins/genericobject/fields/field.
constant.php dosyasından görebilirsiniz.

10.5.9 Bir genel açılan kutu eklemek

Tüm öge türleri için genel bir açılan kutu kullanılabilir. İyi bir örnek şöyle olabilir:

<?php
$GO_FIELDS['categories_id']['name'] = $LANG['common'][36];
$GO_FIELDS['categories_id']['input_type'] = 'dropdown';
$GO_FIELDS['categories_id']['dropdown_type'] = 'global';

Her öge türü için özel bir kategori tablosu oluşturulur. Tablo adı ve alan adı şu şekilde belirlenir:

• tablo : glpi_plugin_genericobject_<itemtypename>_category

• alan adı : plugin_genericobject_<itemtype>categories_id
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10.5.10 Bir tamsayı alanı eklemek

<?php
$GO_FIELDS['testinteger']['name'] = 'testinteger';
$GO_FIELDS['testinteger']['input_type'] = 'integer';
$GO_FIELDS['testinteger']['min'] = 10; //not mandatory, by default 0
$GO_FIELDS['testinteger']['max'] = 40; //not mandatory, by default 100
$GO_FIELDS['testinteger']['step'] = 3; //not mandatory, by default 1

10.5.11 Bir metin alanı eklemek

<?php
$GO_FIELDS['mytextfield']['name'] = 'My text field';
$GO_FIELDS['mytextfield']['input_type'] = 'text';

2.1.2 sürümünde değişti: Şu argümanı ekleyerek, uygulama ekine bir kalıpta kullanıldığında bu alanın otomatik olarak
üretileceğini söylemiş olursunuz:

<?php
$GO_FIELDS['mytextfield']['autoname'] = true;

10.5.12 Bir Evet/Hayır alanı eklemek

<?php
$GO_FIELDS['mybooleanfield']['name'] = 'My boolean field';
$GO_FIELDS['mybooleanfield']['input_type'] = 'bool';

10.5.13 Bir tarih alanı eklemek

<?php
$GO_FIELDS['creationdate']['name'] = $LANG['genericobject']['fields'][30];
$GO_FIELDS['creationdate']['input_type'] = 'date';

10.5.14 Bir tarih ve saat alanı eklemek

<?php
$GO_FIELDS['creationdate']['name'] = $LANG['genericobject']['fields'][30];
$GO_FIELDS['creationdate']['input_type'] = 'datetime';

Not: Bir alanın toplu işlemlerden etkilenmesini istemiyorsanız tanımına şu satırı ekleyin:

<?php
$GO_FIELDS['myfield']['massiveaction'] = false;
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10.6 Genel alanlar eklemek

Alanlarınızın tüm öge türleri tarafından kullanılabilmesi için:

• <GLPI_ROOT>/files/_plugins/genericobject/fields/field.constant.php adında bir dosya oluştu-
run

• Tanımlarınızı bu dosya içine ekleyin.

10.7 Kurulum izinleri

Her profil için her bir nesne türüne göre erişim izinleri tanımlanabilir. Şu seçenekler kullanılabilir:

• Tür izni: Erişilemez, Okuma, Yazma.

• Bu nesne türünü destek kayıtları ile ilişkilendirme izni: Evet, Hayır

İzinleri atamak için şunları yapabilirsiniz:

• Öge türü formundaki İzinler sekmesini kullanın.

• Yönetim > Profiller bölümüne gidin ve her bir profil için izinleri ayarlayın.

10.8 Yeni alanı kullanmak

Yeni türü etkinleştirin ve kullanmaya başlayın.

Kullanıcılar yeni türü Uygulama ekleri > Nesne yönetimi menüsünden kullanabilir.

10.9 Genel nesle ile BDBYS kullanım örneği

10.9.1 Bu belgenin amacı

Biyotıp alanında Genel nesne ile BDBYS (bilgisayar destekli bakım yönetimi sistemi) kullanımını açıklar.

Bu kullanım örneğinin sonunda şunları yapmış olacaksınız :

• Adanmış bir Biyotıp varlığı (“Kök varlık” altında)

• Biyotıp nesneleri (Varlıklar menüsü altında)

• İç ve kullanıcı tanımlı alanlar ile

• Biyotıp_Yönetici profilindeki yönetici kullanıcıları
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10.9.2 Adımlar

Bundan sonraki adımları yapabilmek için Süper Yönetici yetkileriniz olmalıdır :

• GLPI üzerine Genel nesne uygulama ekini yükleyin (Generic Object 0.85 ile 1.0 arasındaki sürümler ve GLPI
0.90 ve üzerindeki sürümler gereklidir)

• Genel nesne yapılandırması

• GLPI yapılandırması

• Genel nesne ve GLPI kullanmaya başlayın

10.9.3 GLPI üzerine Genel nesne uygulama ekini kurmak

ref:install_plugin bölümüne bakın.

10.9.4 Genel nesne yapılandırması

Nesne türünüzü ekleyin

Yeni bir nesne türü ekleyin bölümüne bakın ve iç belirteç olarak biyotıp yazın. Etiket otomatik olarak Biyotıp (Büyük
B ile) olarak ayarlanır.

Oturumu kapatıp yeniden açtıktan sonra Varlıklar menüsünde Biyotıp görüntülenir.

Biyotıp için yeni alanları tanımlayın

Bu alanlar yalnız Biyotıp nesneleri için kullanılabilir :

• Şu adla yeni bir dosya oluşturun : <GLPI_ROOT>/files/_plugins/genericobject/fields/biomedical.
constant.php

• Şu içeriği ekleyin :

<?php
global $GO_FIELDS, $LANG;

// CODE CNEH
$GO_FIELDS['plugin_genericobject_cnehcodes_id']['name'] = $LANG['genericobject'][
→˓'PluginGenericobjectBiomedical'][1];
$GO_FIELDS['plugin_genericobject_cnehcodes_id']['field'] = 'cnehcode';
$GO_FIELDS['plugin_genericobject_cnehcodes_id']['input_type'] = 'dropdown';

// REFORME (yes or no)
$GO_FIELDS['reformed']['name'] = $LANG['genericobject'][
→˓'PluginGenericobjectBiomedical'][2];
$GO_FIELDS['reformed']['input_type'] = 'bool';

// CLASSE CE (3 choix possibles 1,2a ou 2b)
$GO_FIELDS['plugin_genericobject_classeces_id']['name'] = $LANG['genericobject'][
→˓'PluginGenericobjectBiomedical'][3];
$GO_FIELDS['plugin_genericobject_classeces_id']['field'] = 'classce';
$GO_FIELDS['plugin_genericobject_classeces_id']['input_type'] = 'dropdown';

(sonraki sayfaya devam)
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(önceki sayfadan devam)

// UF (Unité Fonctionnelle)
$GO_FIELDS['plugin_genericobject_ufs_id']['name'] = $LANG['genericobject'][
→˓'PluginGenericobjectBiomedical'][4];
$GO_FIELDS['plugin_genericobject_ufs_id']['field'] = 'uf';
$GO_FIELDS['plugin_genericobject_ufs_id']['input_type'] = 'dropdown';

// PRESTATAIRE BIOMED
$GO_FIELDS['plugin_genericobject_prestataires_id']['name'] = $LANG['genericobject
→˓']['PluginGenericobjectBiomedical'][5];
$GO_FIELDS['plugin_genericobject_prestataires_id']['field'] = 'prestataire biomed';
$GO_FIELDS['plugin_genericobject_prestataires_id']['input_type'] = 'dropdown';

// TYPE D'EQUIPEMENT BIOMED
$GO_FIELDS['plugin_genericobject_typedequipementbiomeds_id']['name'] = $LANG[
→˓'genericobject']['PluginGenericobjectBiomedical'][6];
$GO_FIELDS['plugin_genericobject_typedequipementbiomeds_id']['field'] = "type d
→˓'equipement biomed";
$GO_FIELDS['plugin_genericobject_typedequipementbiomeds_id']['input_type'] = 'dropdown';

// Criticite
$GO_FIELDS['plugin_genericobject_criticites_id']['name'] = $LANG['genericobject'][
→˓'PluginGenericobjectBiomedical'][7];
$GO_FIELDS['plugin_genericobject_criticites_id']['field'] = 'criticite';
$GO_FIELDS['plugin_genericobject_criticites_id']['input_type'] = 'dropdown';

// Numéro marquage CE
$GO_FIELDS['plugin_genericobject_marquageces_id']['name'] = $LANG['genericobject'][
→˓'PluginGenericobjectBiomedical'][8];
$GO_FIELDS['plugin_genericobject_marquageces_id']['field'] = 'marquagece';
$GO_FIELDS['plugin_genericobject_marquageces_id']['input_type'] = 'dropdown';

// Classe électrique
$GO_FIELDS['plugin_genericobject_classeelecs_id']['name'] = $LANG['genericobject'][
→˓'PluginGenericobjectBiomedical'][9];
$GO_FIELDS['plugin_genericobject_classeelecs_id']['field'] = 'classeelec';
$GO_FIELDS['plugin_genericobject_classeelecs_id']['input_type'] = 'dropdown';
?>

Uyarı: Başlangıçtaki s_id zorunludur [plugin_genericobject_field*s_id*] çünkü GLPI çatısı için dış
anahtar alanlarının s_id ile bitmesi gereklidir. Veri tabanında, glpi_plugin_genericobject_fields tablo adı-
dır ve id, dış anahtardır. Ayrıntılı bilgi almak için GLPI geliştirici belgeleri bölümüne bakın.
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Alan etiketlerini yazın

ref:edit_labels bölümüne bakın.

• Dil dosyalarınızı düzenleyin, örnek : <GLPI_ROOT>/files/_plugins/genericobject/locales/biyotip/
biyotip.tr_TR.php

• Dosyanın sonuna şu içeriği ekleyin :

<?php
// Fields
$LANG['genericobject']['PluginGenericobjectBiomedical'][1]="Code CNEH";
$LANG['genericobject']['PluginGenericobjectBiomedical'][2]="Réformé";
$LANG['genericobject']['PluginGenericobjectBiomedical'][3]="Classe CE";
$LANG['genericobject']['PluginGenericobjectBiomedical'][4]="UF";
$LANG['genericobject']['PluginGenericobjectBiomedical'][5]="Prestataire Biomed";
$LANG['genericobject']['PluginGenericobjectBiomedical'][6]="Type d'équipement biomed";
$LANG['genericobject']['PluginGenericobjectBiomedical'][7]="Criticité";
$LANG['genericobject']['PluginGenericobjectBiomedical'][8]="Marquage CE";
$LANG['genericobject']['PluginGenericobjectBiomedical'][9]="Classe électrique";

Davranışları tanımlayın

Uygulama ekleri > Nesne yönetimi menüsündeki Temel sekmesinden şunu seçin :

• Öge çöp kutusunda

• Geçmiş

• Mali ve idari bilgiler

• Belgeler

• Genel arama

• Destek

• Kalıplar

• Sözleşmeler

• Genel arama

Bu işlem nesne türünüze kullanmaya hazır alanlar ekler.

Nesne türünüze alanlar ekleyin

Uygulama ekleri > Nesne yönetimi menüsündeki Alanlar sekmesinden Biyotıp türündeki nesneye alanlar ekleyebilir-
siniz :

• Kullanıma hazır alanlar (GLPI iç alanları)

• Yeni alanlar (Biyotıp için yeni alanları tanımlayın bölümünde)
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10.9.5 GLPI yapılandırması

Biyotıp_Yönetim profilini tanımlayın

1. Yönetim profilini kopyalayın

2. Biyotıp-Yönetim profili için şu izinleri ayarlayın :

• Yönetim > Profiller > Yönetim_Biyotıp > Varlıklar sekmesi > Tümünü bırak

• Yönetim > Profiller > Yönetim_Biyotıp > Varlıklar sekmesi > Atama > Destek kaydına atanabilecek ögeler
> Biyotıp

• Yönetim > Profiller > Yönetim_Biyotıp > Yönetim sekmesi > Tümünü seç

• Yönetim > Profiller > Yönetim_Biyotıp > Nesne yönetimi sekmesi > Biyotıp > Tümünü seç

Not: Bu ayarlar ile Yönetim_Biyotıp kullanıcıları Varlık menüsünde yalnız Biyotıp seçeneğini görebilir.

Biyotıp varlığını ve izinlerini tanımlayın

1. “Yönetim > Valıklar* bölümünden Kök varlık altına Biyotıp varlığını ekleyin

2. Biyotıp varlığı kullanıcıları için Biyotıp_Yönetim profili izin kurallarını yapılandırın.

10.9.6 Genel nesne ve GLPI kullanmaya başlayın

Yönetim_Biyotıp kullanıcısı olarak Varlıklar > Biyotıp içine ilk nesnenizi ekleyin.

Zaman kazanmak için Kurulum > Açılan kutular > Nesne yönetimi bölümünden yeni alan değerlerini tanımlayın.

10.10 FAQ

If you have any questions about using the plugin, please consult our FAQ
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News

Download Sources
https://github.com/pluginsGLPI/news/releases https://github.com/pluginsGLPI/news

11.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

11.2 Özellikler

Bu uygulama eki, uyarı iletilerinin GLPI ana sayfasında ve/veya oturum açma sayfasında görüntülenmesini sağlar.

• Notlar için olduğu gibi zengin metin kullanarak uyarılar oluşturur.

• Yayınlanma başlangıç ve bitiş tarihlerini seçilebilir.

• Uyarılar birime göre yönetilebilir.

• Hedef: Uyarılar profile / gruba / kullanıcıya göre görüntülenebilir.
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11.3 Uygulama ekini kurmak

• Arşivi ayıklayın.

• news klasörünü <GLPI_ROOT>/plugins klasörüne taşıyın

• Yapılandırma > Uygulama ekleri bölümüne gidin.

• Uygulama ekini kurup etkinleştirin.

11.4 Kullanım

Bu uygulama eki otomatik olarak veri tabanında gerekli tabloları oluşturur. Bu tablolar uygulama ekiyle birlikte gün-
cellenir.

Uygulama ekinin kullanımı oldukça basittir:

• Uyarıları yapılandırın

Uygulama eki yapılandırması için menüden Araçlar > Uyarılar bölümüne gidin.

11.5 Uyarı oluşturmak

• Ad: Görüntülenecek uyarının başlığını yazın

• Etkin: Uyarının etkin olup olmadığını seçin

• Açıklama: Uyarının içeriğini yazın

• Görüntülenme başlangıcı / bitişi: Uyarının görüntüleneceği zaman aralığını belirtin

• Tür: Uyarının türünü belirtin (Genel, Bilgi, Uyarı, Sorun)

• Uyarı kapatılabilsin mi: Kullanıcının uyarıyı kapatıp kapatamayacağını seçin

• Oturum açma sayfasında görüntülensin: Uyarının oturum açma sayfasında görüntülenip görüntülenmeyeceğini
seçin

• Yardım masası sayfasında görüntülensin: Uyarının yardım masası sayfasında görüntülenip görüntülenmeyeceğini
seçin

• Alt birim: Uyarının alt birimlerde görüntülenip görüntülenmeyeceğini seçin
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11.6 Hedefler

Türe göre hedef belirtebilirsiniz

• Grup: Gruptaki tüm kullanıcılar

• Profil: Belirli bir profildeki tüm kullanıcılar

• Kullanıcı: Belirli bir kullanıcı
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11.7 Oturum açma sayfasında görüntülensin

11.8 Yardım masası sayfasında görüntülensin

11.9 FAQ

If you have any questions about using the plugin, please consult our FAQ
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OAuth IMAP

Download Sources
https://github.com/pluginsGLPI/oauthimap/releases https://github.com/pluginsGLPI/oauthimap

Not: Microsoft is gradually removing the TLS 1.0 and 1.1 protocols for all Microsoft 365 applications. In order to
keep your collector running, you need to add the Oauth IMAP plugin, which is available in the marketplace.

Tüyo: The Oauth tokens for the collector, retrieved during authentication with Azure by the OauthIMAP plugin, are
“offline” tokens that delegate authorisation to a third-party application (GLPI). These tokens provide a renewal code
that will be used by the application to renew them automatically without user intervention. You will therefore not be
asked to re-authenticate after the 1st authorisation request.

12.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: This plugin is available without a GLPI-Network subscription. It is also available in Cloud
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12.2 Supported mail services

OAuth IMAP support :

• Gmail : https://developers.google.com/gmail/imap/xoauth2-protocol?hl=fr

• Entra : https://learn.microsoft.com/fr-fr/power-platform/admin/connect-gmail-oauth2

12.3 Install the plugin

• Go to the marketplace. Download Oauth IMAP and enable it

• Open the Azure Portal for your tenant

• In the search box type registration

• then select App registrations

Here are the configuration steps including configuration phases on the Entra side.

12.4 Register your Entra application

12.4.1 Create the application

• Click on New registration

• Enter the desired name, select the type of account supported then enter the redirection URL (present in the
configuration of the plugin from your GLPI interface: https://XXXXXXXXXXXXXX/marketplace/oauthimap/
front/authorization.callback.php) specifying the Web option
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• Then click on Register.

12.4.2 Add a secret

• In the Certificates and secrets tab

• Click on Client secrets

• Then New client secret

• Enter a description and then an expiration date

• A secret value is then generated. Keep this value well because once you have left this page, it will no longer be
recoverable

• Return to the Overview tab and copy the following values and the secret seen above
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12.5 Setup GLPI

• Now go back to your GLPI interface Setup > Application Aouth IMAP and indicate the information collected
previously :

• Click Add

• Now in the Oauth authorization tab, click Create an authorization

• When you click on Create authorization, you will be redirected to the Microsoft services sign-in page

• Enter the email address and password of the account that will be used for the collector

• You will also need to accept the necessary permissions related to the plugin.
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12.6 FAQ

If you have any questions about using the plugin, please consult our FAQ
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BÖLÜM 13

Sipariş

Download Sources
https://github.com/pluginsGLPI/order/releases https://github.com/pluginsGLPI/order

13.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

13.2 Özellikler

Bu uygulama eki, aşağıdaki sipariş yönetimi özelliklerini destekler:

• Ürün referansları kataloğunun tanımlanması ve yönetimi

• Sipariş yönetimi (onay iş akışı ile)

• Bütçe yönetimi

• Siparişlerle ilgili faturaların yönetimi
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13.3 Uygulama ekini kurmak

• Arşivi ayıklayın.

• order klasörünü <GLPI_ROOT>/plugins klasörüne taşıyın

• Yapılandırma > Uygulama ekleri bölümüne gidin.

• Uygulama ekini kurup etkinleştirin.

13.4 Yapılandırma

Uygulama eki yapılandırması için menüden Yapılandırma > “Uygulama ekleri” > Sipariş yönetimi bölümüne gidin.

Uygulama eki kurulup etkinleştirildiğinde, aşağıdaki seçenekler kullanılabilir:

• Varsayılan KDV: Uygulama ekinde varsayılan olarak kullanılacak KDV oranı

• Doğrulama yapılsın: Tam doğrulama devresinin kullanılması gerekip gerekmediğini ya da herhangi birinin uy-
gulamaları doğrulayıp doğrulayamadığını belirler.

• Satınalma siparişi oluşturma: Bu seçenek etkinleştirildiğinde, satınalma siparişinin ODT biçiminde oluşturul-
masını sağlayan sekme görüntülenir.

• Sağlayıcı memnuniyeti ölçülsün: Bu seçenek etkinleştirildiğinde, sipariş teslim edildikten sonra sağlayıcı mem-
nuniyetini değerlendirme sekmesi görüntülenir.

• Satınalma siparişi satıcı bilgileri görüntülensin: Bu seçenek etkinleştirildiğinde, referans ve satıcı satınalma si-
parişi numarasının kaydedileceği sekme görüntülenir.

• Öngörülen teslim tarihi aşıldığında renk: Öngörülen teslim tarihi aşıldığı halde teslim edilmemiş bir siparişin
arama motorunda görüntüleneceği renk
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• Yeni bir öge oluşturulduğunda sipariş belgeleri kopyalansın: Bu seçenek etkinleştirildiğinde, sipariş belgeleri
oluşturulan ögeye kopyalanır

• Bir siparişe belge eklerken varsayılan başlık : Varsayılan başlığı belirler

• Yetkili grup (varsayılan değerler): Varsayılan yetkiliyi belirler

• Alıcı grubu (varsayılan değerler): Varsayılan alıcı grubunu belirler

• Alıcı (varsayılan değerler): Varsayılan alıcıyı belirler

• Süresi dolan bütçeler görüntülenmesin: Evet ya da hayır

• Bütçe değişikliği bağlantılı varlıklara iletilsin: Evet ya da hayır

• Sipariş formunda hesap bölümü görüntülensin: Evet ya da hayır

• Sipariş formunda hesap bölümü zorunlu olarak ayarlansın: Evet ya da hayır

• Özgür referanslar kullanılsın: Evet ya da hayır

• Eklenen belgeler sırayla yeniden adlandırılsın: Evet ya da hayır

13.4.1 Öge teslim edilirken otomatik işlemler

Oluşturma, sözleşmeler, kartuşlar ve sarf malzemeleri için geçerli değildir. Bu özelliği etkinleştirmek için Otomatik
oluşturulsun seçeneğini evet olarak değiştirin ve doğrulayın. Oluşturma sırasında, materyal bazı rastgele bilgilerle dol-
durulur:

• Varsayılan ad

• Varsayılan seri numarası

• Varsayılan stok numarası

• Parça numarası ile bir kalıp ilişkilendirilirse ve bu kalıpta ad ve seri numarası oluşturulursa, bu iki alan için
yukarıda belirtilen ayarlar geçerli olmaz.

Malzeme oluşturulduğunda varsayılan durum ayarlanır. Materyalin oluşturulması sırasında durumun konumlandırıl-
ması, mali bilgilerde bir tarih doldurulmasına yol açabilir. Birim envanteri sekmesine bakın.
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13.4.2 Sipariş yaşam döngüsü

Sipariş yaşam döngüsü için kendi durumunuzu tanımlayabilirsiniz

13.5 Referans kataloğunu oluşturmak

Referans kataloğuna Yönetim > Siparişler > Ürün referansları bölümünden erişebilirsiniz.

Ürün referanslarının oluşturulması, sipariş yönetimi için ön koşuldur. Sipariş edilecek herhangi bir ürüne uygulama eki
kataloğunda atıfta bulunulmalıdır. Ürün referansı oluştururken aşağıdaki alanlar doldurulmalıdır:

• Alt birimler: Referansın yalnız var olan birimde mi yoksa alt birimlerde de mi görüntülenip görüntülenmeyece-
ğini belirtir.

• Ad: Bir sipariş yönetilirken görüntülenecek referansın adı (zorunlu)

• Üretici: Ürünün üreticisi (sağlayıcı değil)

• Aygıt türü: Ne tür bir aygıtla uğraştığımızı belirtir

• Tür: Ürünün türü

• Model: Ürünün modeli

• Kalıp: Zaten varsa ürünün GLPI kalıbı.

• Açıklamalar: Referans hakkında ek bilgiler

• Referans oluşturulduktan sonra, ürünün temin edildiği sağlayıcıların ve bununla ilişkili fiyatın belirtilmesi gere-
kir.

Şunlar da yapılabilir:

• İlişkili belgeler eklenebilir
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• Geçmiş görüntülenebilir

13.6 Bir sipariş oluşturulabilir

Siparişlere Yönetim > Siparişler > Siparişler bölümünden erişebilirsiniz.

Referans kataloğu oluşturulduktan sonra malzeme siparişleri eklenebilir. Doldurulması gereken alanlar şunlardır:

• Alt birimler: Siparişin alt birimlerde görüntülenip görüntülenmeyeceğini belirler

• Sipariş adı

• Sipariş numarası (zorunlu)

• Sipariş tarihi (zorunlu)

• Bütçe: Satınalma siparişinin kaydedildiği bütçe.

• Satıcı satınalma sipariş numarası: Satıcı tarafındaki satınalma siparişinin numarası.

• Ödeme koşulları: Serbest alan (ay sonu 30 gün, ay sonu 60 gün gibi bilgiler)

• Fatura numarası

• Sağlayıcı: Siparişin verildiği sağlayıcı. Yalnız bu sağlayıcının katalog referansları siparişe eklenebilir.

• Siparişin teslim yeri: Aygıtın teslim edileceği yeri belirtir. Bu seçeneğin yalnız siparişin oluşturulduğu birimde
değeri vardır.

• Açıklama: Siparişin açıklaması

• Durum: Yayın çalıştırmasındaki satınalma siparişinin güncel durumunu görüntüler.

• Öngörülen teslimat tarihi: Sağlayıcının siparişi teslim etmesi öngörülen tarihi belirtir.

Şunlar da yapılabilir:

• Yetkili ve alıcıyı belirtin
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13.6.1 Ürünleri eklemek

Şimdi ayrıntılar sekmesinden siparişe ürünler eklenebilir.

• Siparişe eklenecek malzeme türünü seçin

• Ürün numarasını seçin

• Sipariş edilecek miktarı belirtin

• Ürün referansında belirtilen fiyat geçerli değilse birim fiyatını değiştirin.

• Ürünlerin indirim yüzdesini belirtin

• Şimdi bu ürünlerin siparişe eklenmesini doğrulayabilirsiniz.

Not: Sipariş düzenlenirken bir takım malzemelerin fiyatını ve indirimini değiştirebilirsiniz. Bunu yapmak için, bu iki
alandan birine çift tıklayın, değerini değiştirin ve değişikliği doğrulayın.
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13.6.2 Doğrulama iş akışı

Uygulama ekinin doğrulama iş akışı şu şekildedir:

• Sipariş oluşturma: Sipariş işleniyor durumundadır

• Sipariş onayı isteği: Sipariş onay bekleniyor durumundadır

• Sipariş onaylandı: Sipariş teslimat sürecinde durumuna geçer.

• Sipariş tamamen alındı: Sipariş otomatik olarak teslim edildi durumuna geçer

• Satınalma siparişi iptal edildi: Sipariş İptal edildi durumuna geçer

Onay isteğinde bulunma, siparişi onaylama ya da iptal etme yetkisi olan kişilerin tanımı profil düzenlemesi ile yapılır.

13.6.3 Sipariş alımı

Sipariş onaylandıktan sonra, aygıtı teslim alma işlemine başlanabilir. Bunun için, Aygıtları alma sekmesine gitmelisiniz.
Her ürün, şu bilgileri içeren bir satırla tanımlanır:

• Ürün referansı

• Alınan aygıt sayısı

• GLPI envanter ögeleri ile ilgili malzeme sayısı

• Ürünün birim fiyatı (KDV hariç)

• Ürünün birim fiyatı (KDV dahil)

• Ödenen birim fiyatı (KDV hariç)

Satırın solundaki + simgesine tıklayarak sipariş edilen ürünlerin ayrıntılarına erişilebilir.
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13.6.4 Malzeme alımı

Sipariş onaylandığı andan itibaren sipariş edilen malzeme teslim alınabilir. Malzeme alımı sekmesine gitmeniz gerekir.
Sipariş edilen her ürün referansı için bir satır görüntülenir. Bu satırda şu bilgiler bulunur:

• Ürün referansı

• Alınan aygıtlar: Bu ürün için sipariş edilen toplam aygıt sayısından alınan aygıt sayısını gösterir.

• İlgili aygıtlar: GLPI üzerindeki envanter ögeleriyle ilgili alınan mal sayısı

• Birim fiyatı (KDV hariç)

• Birim fiyatı (KDV dahil)

• Ödenen birim fiyatı (KDV hariç)

Ürün alımına devam etmek için satırın solundaki + simgesine tıklayın.

Malzeme almanın 2 yolu vardır:

• Sipariş edilen ancak henüz teslim alınmayan ürünler listesinden seçilen malzemelerin alınması

• Malzemelerin toplu olarak alınması: Bu durumda kaç adet ürün teslim alındığı belirtilir (önce listeden seçim
yapmadan).

Her iki durumda da, malzemenin teslim alınmasıyla ilgili sevk irsaliyesinin iade edilmesi gerekir. Alternatif olarak,
alınan nesnelerin durumu belirtilebilir uygun, uygun değil gibi). Alındıktan sonra şunlar yapılabilir:

• Alınan üründen GLPI üzerinde bir malzeme oluşturulabilir

• Alınan ürün var olan bir GLPI aygıtına bağlanabilir
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13.6.5 Malzeme üretme

Alınan ürünlerden malzeme üretmek için listeden bu işlemin yapılacağı ürünlerin seçilmesi yeterlidir. Ardından ilişkili
malzeme oluştur seçeneğini seçin. Görüntülenen sayfada her satır alınan bir ürünü gösterir ve şu bilgiler verilmelidir:

• GLPI üzerinde üretilen malzemenin adı

• Seri numarası

• Varlık numarası

Not:

• Oluşturulan ürünün referansıyla ilişkili bir kalıp varsa ve ikincisi referans ile aynı birimde oluşturulmuşsa, GLPI
üzerindeki envanter varlığı bu kalıptan oluşturulur.

• Siparişin mali bilgileri, yeni oluşturulan stok nesnesinde bulunur.

13.6.6 Bir envanter ögesine bağlamak
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Alınan bir ürün üretilmek yerine, GLPI üzerinde zaten var olan bir malzemeye bağlanabilir. Bunun için, var olan bir
malzemeye bağla seçeneğini seçin. Bir açılan kuruda GLPI üzerinde bulunan tüm malzemeler şuna göre görüntülenir:

• Siparişin birimindeyse (ya da sipariş alt birimlere görüntüleniyorsa bir alt birimdeyse)

• Aynı aygıt türündeyse

• Aynı aygıt türündeyse

• Aynıysa

Bir ürüne bağlandıktan sonra, GLPI üzerindeki malzeme siparişten mali bilgileri alır.

13.7 İzin yönetimi

Uygulama eki izin yönetimi, kullanıcının profilinden aşağıdaki izinleri tanımlamayı sağlar:

• Komut yönetimi

• Ürün referansları yönetimi

• Fatura yönetimi

• Sipariş onayı

• Sipariş iptali

• Onaylanmış sipariş değişikliği

13.8 FAQ

If you have any questions about using the plugin, please consult our FAQ
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PDF

14.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: This plugin is available without a GLPI-Network subscription. It is also available in Cloud.

14.2 Install the plugin

• Go to the marketplace. Download and install the plugin PDF
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14.3 Set up the plugin

• From Setup > General > Print to pdf, select :

– your preferred currency

– Any text that will be displayed on the PDF.

14.4 Using the plugin

Not: Printing a contract and its related elements

• From Management > Contracts, select the contract you require

• From the Print pdf tab

• Click on Print
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SCCM

İndir Kaynaklar
https://github.com/pluginsGLPI/sccm/releases https://github.com/pluginsGLPI/sccm

15.1 Son sürümün gereksinimleri

Bu uygulama ekinin gereksinimleri:

• PHP 7.2 ve üzerindeki sürümler

• GLPI 9.4 ve üzerindeki sürümler

• GLPI için FusionInventory uygulama eki

• SCCM 1802 ve üzerindeki sürümler

• PHP curl_init ve sqlsrv_connect

• Microsoft System Center Configuration Manager

• PHP için Microsoft SQL Server sürücüleri

Not: Bu uygulama eki bir GLPI-Network aboneliği olmadan kullanılabilir. Cloud üzerinde bulunmuyor
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15.2 Özellikler

Bu uygulama eki SCCM üzerindeki bilgisayarları (sürüm 1802) GLPI ile (sürüm 9.3 ve 9.4) eşitlemek için kullanılır.
“GLPI FusionInventory” uygulama eki ve iç işleyicinin gücünü kullanır.

15.3 İş akışı

• Bu uygulama eki iki otomatik işlem ekler: “SCCMCollect” ve “SCCMPush”

• Otomatik “SCCMCollect” işlemi, SCCM sunucusuna MsSQL sorguları gönderir.

• Aynı işlem, her bilgisayar için bir XML dosyası oluşturur (FusionInventory biçiminde).

• Otomatik “SCCMPush” işlemi, bilgisayarı GLPI üzerinde görüntülemek için XML dosyalarını http(s) iletişim
kuralı üzerinden GLPI üzerine (cURL ve FusionInventory aracılığıyla) aktarır.

15.4 Şematik çizim
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15.5 Toplanan veriler

SCCM sunucusundaki verilerin kullanılabilirliğine bağlı olarak, her bilgisayar için şu veriler toplanır:

• Bilgisayar: Ad, son bağlanan kullanıcı, UUID, kullanıcı oturumu açma, etki alanı, açıklama, seri no

• İşletim sistemi: Ad, mimari, sürüm, hizmet paketi

• BIOS bilgileri: Etiket, model, tür, üretici, seri no, kurulum tarihi, sürüm

• İşlemci: Açıklama (veya ad), üretici, frekans, tür (mimari), çekirdek sayısı, işlem sayısı

• Yazılımlar: Ad, sürüm, düzenleyici, kurulum tarihi

• Bellek (RAM): Kapasite, açıklama, frekans, tür, veri yolu, seri no

• Görüntü kartı: Ad, yonga seti, bellek

• Ses kartı: Ad, üretici

• Ağ kartı: Ad, MAC adresi, IP adresi (v4, v6)

• Disk bölümü: Ad, bağlama türü, toplam boyut

15.6 Otomatik işlemler
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15.6.1 SCCMCollect

SCCM üzerinden XML dosyalarına veri toplama işlemi.

15.6.2 SCCMPush

XML dosyasını FusionInventory uygulama ekine gönderme işlemi
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Treeview

İndir Kaynaklar
https://github.com/pluginsGLPI/treeview/releases https://github.com/pluginsGLPI/treeview

16.1 Son sürümün gereksinimleri

16.2 Gereksinimler (özel kurulum)

GLPI sürümü En düşük PHP sürümü Önerilen
10.0.x 8.1 8.2

Not: Bu uygulama eki bir GLPI-Network aboneliği olmadan kullanılabilir. Ayrıca Cloud üzerinde de bulunuyor

16.3 Özellikler

Bu uygulama eki, ekranın sol tarafındaki bir panoda görüntülenen bir ağaç ile envanterinize göz atabilmenizi sağlar.

Aygıtı görmek için sitenizin ağacına göz atabilirsiniz.
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16.4 Uygulama ekini kurmak

• Arşivi ayıklayın.

• tag klasörünü <GLPI_ROOT>/plugins klasörüne taşıyın

• Yapılandırma > Uygulama ekleri bölümüne gidin.

• Uygulama ekini kurup etkinleştirin.

16.5 Kullanım

Bu uygulama eki otomatik olarak veri tabanında gerekli tabloları oluşturur. Bu tablolar uygulama ekiyle birlikte gün-
cellenir.

Uygulama ekinin kullanımı oldukça basittir:

Oluşturma formuna Kurulum > Uygulama ekleri > Treeview bölümünden erişebilirsiniz.

• Tüm düğümler için hedef: Düğüme tıklandığında yeni pencereye yönlendirilir

• Düğümler vurgulanabilir: Seçilmiş düğüm vurgulanır ya da vurgulanmaz

• Ağaç çizgilerle çizilir: Görüntülenir ya da görüntülenmez

• Ağaç simgelerle çizilir: Düğüm simgesi görüntülenir ya da görüntülenmez

• Aynı anda yalnız bir üst düğüm genişletilebilir: Aynı anda birden fazla üst düğüm genişletilebilir

• Öğe adı: Ad ya da envanter numarası ya da ad + envanter numarası ya da envanter numarası + ad

• Konum adı: Kısa ad ya da uzun ad ya da uzun ad + yorum ya da uzun ad + yorum
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Tag

Download Sources
https://github.com/pluginsGLPI/tag/releases https://github.com/pluginsGLPI/tag

17.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: This plugin is available without a GLPI-Network subscription. It is also available in Cloud.

17.2 Install the plugin

• Go to the marketplace. Download and install the plugin “Tag”.
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17.3 Setting up the plugin

• From Setup > Dropdowns

• Click on Tag management

• Then Tags

• Enter a name that will be visible when tags are added

• Enter a description (optional)

• Add a colour

• Associate one or more elements. If nothing is ticked, it will not be visible in any element by default.
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17.3.1 Choose where to find the tag

You can indicate whether the tag should be at the top or bottom of the list.

• From Setup > General > Tag management, specify the tag location.

Bottom :

Top:

17.4 Adding rules

You can add business rules (tickets, computers, etc.) to add tags to particular items.

Example : Assign a VIP tag when a member of the management group writes a ticket.

• Here are the criteria to be implemented from Administration > Rules > Business rules for tickets

• After creating a ticket :

Not: Tags can, of course, be added manually if they have been set to be visible in the specified item.

17.5 FAQ

If you have any questions about using the plugin, please consult our FAQ
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Kaldır

İndir Kaynaklar
https://github.com/pluginsGLPI/uninstall/releases https://github.com/pluginsGLPI/uninstall

18.1 Gereksinimler (özel kurulum)

GLPI sürümü En düşük PHP sürümü Önerilen
10.0.x 8.1 8.2

Not: Bu uygulama eki bir GLPI-Network aboneliği olmadan kullanılabilir. Ayrıca Cloud üzerinde de bulunuyor

18.2 Özellikler

“Kaldır” ya da “Öğe kaldır” olarak adlandırılan bu uygulama eki, alanlar üzerinde yapılan belirli işlemleri otomatik-
leştirerek aygıtları envanterden kaldırmanızı / değiştirmenizi sağlar.

Bir donanımın yaşam döngüsünün farklı aşamalarının yönetilmesini sağlar. Diğer şeylerin yanında aşağıdaki durumları
ele almak üzere tasarlanmıştır:

• Aygıtın hurdaya çıkarılması

• Bozulma nedeniyle geçici aygıtın envanterden çıkarılması

• Aygıtın garanti kapsamında değiştirilmesi (aygıt değiştirme özelliği)

Kurulduğunda uygulama ekinde şunlar bulunur:
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• Yönetim -> Profiller bölümünden doğrudan erişilebilen bir izin yönetimi (Uygulama ekleri sekmesinde -> Kal-
dır),

• “Yapılandırma” bölümünde “Donanımı kaldır” menüsü,

• Kullanıcı ayarlarında “kaldır” menüsü.

18.3 İzin yönetimi

Uygulama ekinin erişimi reddedilebilir ya da kalıplarda okuma ya da yazma seçeneği belirtilerek izin verilebilir.

Bunu yapmak için, “Yönetim” > “Profiller” menüsüne giderek değiştirmek istediğiniz profili seçin. Ardından “Kaldır”
sekmesinde aşağıdaki seçenekleri ayarlayın:

• Erişim yok: Uygulama eki ‘Uygulama ekleri’ menüsünde görüntülenmez.

• Oynatma: Yalnız önceden oluşturulmuş kalıplar kullanılabilir

• Writing: Kalıp oluşturulabilir.

• Donanım değişikliği: Standart donanım değişikliği yapılabilir

18.4 Kaldırma özelliği

‘Öğe kaldır’ uygulama ekinin bu özelliği, belirli alanların değerini değiştirme ve OCS tabanındaki bir bilgisayarın
envanterini kaldırma ya da FusionInventory tablolarını temizleme olanağı sağlar.

Kaldırma kalıplarına “Yönetim > Donanımı kaldır” menüsünden erişilebilir.

İstediğiniz kadar kaldırma kalıbı oluşturabilirsiniz. Her kalıpta farklı özellikler bulunabilir ve alt birimlerde görüntü-
lenebilir ya da görüntülenmeyebilir.

Aygıt kaldırma, aygıtın kendisine devredilmesidir. Aktarım sırasında, aktarım tanımında belirtilen işlemler gerçekleş-
tirilir.

• Ad: Kaldırma kalıbının adı

• Alt birimler: Kalıbın oluşturulduğu birimde ve alt birimlerinde görünür olup olmayacağını belirtir

• Model türü: Kullanılacak model türünü belirtir (kaldır ya da değiştir)
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• Yorumlar: Modelle ilgili ayrıntıların yazılabileceği alanlar sağlar

• Kullanılacak aktarım kalıbı: Sistemi kaldırırken kullanılacak aktarım kalıbını belirtir.

• Yeni donanım durumu: Kaldırıldıktan sonra donanıma atanacak durumu belirtir

• Yeni grup: Kaldırıldıktan sonra donanımın ait olabileceği grubu belirtir.

• Yazılım geçmişi silme : Bir bilgisayarın geçmişindeki yazılım kurma/kaldırma işlemleriyle ilgili tüm satırların
silinmesini sağlar.

• Adı sil : Kaldırma sırasında donanımın adını kaldırır

• RAZ ilgili : Kaldırma sırasında OCS tarafından eklenen ilgiliyi kaldırır

• Ağ sıfırlama: Aygıt kaydının “ağ” alanını sıfır olarak ayarlar.

• RAZ işletim sistemi: Kaldırma sırasında işletim sistemi bilgilerini (işletim sistemi sürüm, hizmet paketi, ürün
anahtarı, ürün kimliği) kaldırır.

• RAZ etki alanı : Donanımdan “etki alanı” alanını kaldırır

• IP ve ağ geçidini ve hacker ve alt ağı kaldır: Kaldırma sırasında ağ bilgilerini (donanımla ilgili MAC adresi
dışında) kaldırır

• Bilgisayarı OCS üzerinden kaldır : GLPI üzerinde bir bilgisayarı kaldırırken, OCS veri tabanından da kaldırır

• FusionInventory bilgilerini sil: Bu materyal için tüm FusionInventory bilgilerini siler

18.5 Donanımı kaldırmak

Bir donanımı kaldırmanın 2 yolu vardır:

• Donanım kaydındaki “Kaldır” sekmesinden.

• Toplu değişiklik listesinden

Bir kalıp hiyerarşide aşağıya doğru geçerli olabileceğinden (alt birimlerde görüntülenir), toplu işlemlerde görüntülenen
kalıpların listesi, geçerli birimde kullanılabilecek tüm kalıpları gösterir (ya bu birimde tanımlananlar ya da bu birimin
üzerindeki bir birimde ve alt birimlerinde görüntülenenler).
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18.5.1 Kaldırma sırasında konumu değiştirmek

Kaldırıldıktan sonra donanımın konumu değiştirilebilir. Bu işlem iki şekilde yapılabilir:

• Kaldırma modeli seçildikten sonra donanım dosyasından.

• Toplu değişiklikle kaldırma için kullanıcının ayarlarından

Bir birim içinde bir konumun bildirildiğine dikkat edilmelidir. Bu nedenle, var olan birime bağlı olarak bir kaldırma
konumu belirtilebilir.

18.6 Değiştirme özelliği

‘Öge kaldır’ uygulama ekinin bu özelliği, bir donanımın diğeriyle değiştirilebilmesini sağlar.

18.6.1 Değişiklik modeli formu

Değişiklik modelleri, kaldırma modelleriyle aynı şekilde yönetilir: Bunlara “Yönetim > Donanım kaldır” menüsün-
den erişilebilir. Her modelde farklı özellikler bulunabilir ve alt birimlerde görüntülenmesi ya da görüntülenmemesi
sağlanabilir.

Bu formda 4 sekme bulunur:

• Temel: Sayfada kalıbın yalnızca temel bilgilerinin görüntülenmesini sağlar.

• Verileri değiştirme: Bir aygıtı bir başkasıyla değiştirirken yapılacak çeşitli işlemleri görüntüler.

• Tümü: Tüm sekmeleri aynı sayfada görüntüler

Temel bilgiler sekmesindeki alanlar şunlardır:

Ad: Değiştirilen modelin adı Alt birimler: Kalıbın oluşturulduğu birimde ve alt birimlerinde görüntülenip görüntü-
lenmeyeceği Model türü: Ne tür bir modelin kullanılması gerektiği (Değiştirme işlemi için) Açıklama: Modelle ilgili
ayrıntıların eklenebileceği boş alanlar Yeni donanım durumu: Değiştirildikten sonra eski donanıma atanacak durum
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18.6.2 Değişiklik bilgileri sekmesi

İşlemler sekmesindeki alanlar şunlardır:

Genel bilgiler

• Ad kopyalansın: Eski donanımın adının yenisine kopyalanmasını sağlar.

• Seri numarası kopyalansın: Eski aygıtın seri numarasının yenisine kopyalanmasını sağlar.

• Envanter numarası kopyalansın: Eski aygıtın envanter numarasının yenisine kopyalanmasını sağlar.

• Bilgileri değiştir (eski aygıttan yenisine): Bu seçenek, eski aygıtta varsa eşsiz bilgilerden (ayırtma, mali bilgiler,
ad, seri, diğer seri, birim. . . ) birini seçmenizi VE yeni aygıtta: Evet : EVET seçildiğinde, eski aygıttaki bilgiler
yeni aygıttaki bilgilerin yerini alır. Hayır: HAYIR seçildiğinde, eski aygıt bilgileri ASLA yeni aygıt bilgilerinin
üzerine yazılmaz.

Eski aygıtın arşivlenme yöntemi

Bu seçenekte, kaldırma uygulama ekinin eski aygıttan alması gereken bilgiler tanımlanır:

• Temizle + PDF / CSV : PDF uygulama ekiniz varsa, eski aygıt GLPI veri tabanından temizlenir ve bilgileri bir
PDF belgesi olarak yeni donanıma eklenir. PDF uygulama ekiniz yoksa, bu bilgiler CSV biçiminde kaydedilir.

• Silme + Açıklamalar: Eski aygıt çöp kutusuna atılır ve iki aygıta da birer açıklama eklenir (“Bu aygıtın yerine şu
aygıt takıldı. . . ve “Bu aygıt şu aygıtın yerine takıldı. . . ”) .

Konum verisi - Diğer donanımlarla bağlantı

• Belgeler kopyalansın: Eski aygıttaki belgelerin yeni aygıta aktarılmasını sağlar.

• Sözleşmeler kopyalansın: Eski aygıttaki sözleşmelerin yeni aygıta aktarılmasını sağlar.

• Mali bilgiler kopyalansın: Eski aygıttaki mali bilgilerin yeni aygıta aktarılmasını sağlar. Uyarı: “Bilgilerin üzerine
yazılsın” seçeneği etkinleştirildiğinde, yeni aygıtın mali bilgileri var olsa bile, eski aygıtın bilgileri ile değiştirilir.

• Ayırtma bilgileri kopyalansın: Eski aygıttaki ayırtma bilgilerinin yeni aygıta aktarılmasını sağlar. Uyarı: “Bilgile-
rin üzerine yazılsın” seçeneği etkinleştirildiğinde, yeni aygıtın ayırtma bilgileri var olsa bile, eski aygıtın bilgileri
ile değiştirilir.

• Kullanıcı kopyalansın: Eski aygıttaki kullanıcı bilgilerinin yeni aygıta aktarılmasını sağlar. Uyarı: “Bilgilerin
üzerine yazılsın” seçeneği etkinleştirildiğinde, yeni aygıtın kullanıcı bilgileri var olsa bile, eski aygıtın bilgileri
ile değiştirilir.
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• Grup kopyalansın: Eski aygıttaki grup bilgilerinin yeni aygıta aktarılmasını sağlar. Uyarı: “Bilgilerin üzerine
yazılsın” seçeneği etkinleştirildiğinde, yeni aygıtın grup bilgileri var olsa bile, eski aygıtın bilgileri ile değiştirilir.

• Destek kayıtları kopyalansın: Eski aygıttaki destek kayıtlarının yeni aygıta aktarılmasını sağlar.

• Ağ bağlantıları kopyalansın: Eski aygıttaki ağ bağlantılarının yeni aygıta aktarılmasını sağlar.

• Doğrudan bağlantılar kopyalansın: Eski aygıttaki doğrudan bağlantıların (ekran, yazıcı, aygıt, telefon) yeni aygıta
aktarılmasını sağlar.

18.7 Donanım değiştirme

Aygıtı kaldırmanın yanında aygıtı değiştirmenin de iki yolu vardır:

• Kartından, “Uygulama ekleri -> Kaldır” sekmesinden,

• Toplu değişiklik listesinden.

Bir değişiklik hiyerarşide aşağıya doğru geçerli olabileceğinden (alt birimlerde görüntülenir), toplu işlemlerde görün-
tülenen kalıpların listesi, geçerli birimde kullanılabilecek tüm kalıpları gösterir (ya bu birimde tanımlananlar ya da bu
birimin üzerindeki bir birimde ve alt birimlerinde görüntülenenler).

Toplu işlemlerle değiştirilecek donanımı seçtikten ya da doğrudan kartındaki “Kaldır” sekmesini kullandıktan sonra:

• Uygulama eki tarafından gerçekleştirilecek işlemleri size göstermek için seçilen kalıbın bir özeti görüntülenir.

• Seçilmiş donanım(lar)ın listesi görüntülenir ve bir destek kaydında bir donanım seçerken olduğu gibi değiştirilen
donanımı seçebilirsiniz.

18.7.1 Değiştirme sırasında konumu değiştirmek

Değiştirildikten sonra aygıtın yeri değiştirilebilir. Bu seçim şu şekillerde yapılabilir:

• aygıt sayfasında değiştirilecek model seçildikten sonra,

• toplu değişiklik değişimi için kullanıcının ayarlarından.

Bir birim içinde bir konumun bildirildiğine dikkat edilmelidir. Bu nedenle, var olan birime bağlı olarak bir değiştirme
konumu belirtilebilir.
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18.8 SSS

Uygulama ekinin kullanımıyla ilgili herhangi bir sorunuz varsa SSS bölümüne bakabilirsiniz.
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BÖLÜM 19

Advanced dashboards

19.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A standard licence (or higher) is required. This plugin is also available from the Cloud.

19.2 Install the plugin

• Go to the marketplace. Download and install the “Advanced dashboard” plugin.
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19.3 Setup the plugin

Uyarı: This plugin requires a minimum knowledge of SQL in order to be able to set certain criteria for the various
queries that will appear in the dashboards. It is also recommended that you know the structure of GLPI tables.

19.3.1 Create an SQL query

The below example gives us the number of tickets on the root entity over the last 2 years:

SELECT YEAR(t.date_creation) as 'Year', count(*) as 'Volume of tickets'
FROM glpi_tickets t
JOIN glpi_entities e on t.entities_id = e.id
WHERE e.completename LIKE "Root entity"

AND YEAR(t.date_creation) > YEAR(CURRENT_DATE()) - 5
GROUP BY YEAR(t.date_creation)
UNION
SELECT

CONCAT('Estimated total end ', YEAR(CURRENT_DATE())),
ROUND(

(
SELECT count(*)
FROM glpi_tickets t4
JOIN glpi_entities e4 on t4.entities_id = e4.id

WHERE e4.completename LIKE "Entité racine" (root entity)
AND YEAR(t4.date_creation) = YEAR(CURRENT_DATE()) - 1

) *
(

(
SELECT count(*)
FROM glpi_tickets t3
JOIN glpi_entities e3 on t3.entities_id = e3.id
WHERE e3.completename LIKE "Root entity"

AND YEAR(t3.date_creation) = YEAR(CURRENT_DATE())
)
/
(

SELECT count(*)
FROM glpi_tickets t2
JOIN glpi_entities e2 on t2.entities_id = e2.id
WHERE e2.completename LIKE "Root entity"

AND YEAR(t2.date_creation) = (YEAR(CURRENT_DATE()) - 1)
AND (

MONTH(t2.date_creation) < MONTH(CURRENT_DATE())
OR MONTH(t2.date_creation) = MONTH(CURRENT_DATE()) AND DAY(t2.

→˓date_creation) <= DAY(CURRENT_DATE())
)

)
)

)
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19.3.2 Setting query-related parameters

• From tools > SQL for dashboards, click on add

• Name your query (the one that will be visible from the dashboards) and identify it as active.

• In the SQL Editor tab, paste the above query, taking care to change the name of the entity if you have changed it.

• Click on the floppy icon to save the query and then on play icon to run the query.

An insert at the bottom will display the result of the query:

• In the set up fields tab, define the label, the number and the main label (optional, this is the name your table will
have). In our case, the label will be “year”, the number will be “number of tickets” and the main label will be
“”number of tickets per year”.

• Select the type of graph (this is for information purposes only, so that you can preview your table; you will be
asked to select the type of graph you want to appear in the tile later),

• You can limit the amount of data to be displayed.

• Then click on Save fields and preview.

19.3.3 Dashboard settings

• From Assistance > Dashboard, select the dashboard that is to receive the new tile

• Click on edit icon

• Add a new tile with plus icon

• Select the query you have just created

• Choose a colour for your tile

• You will then be asked to select the chart type
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• Some dashboards may ask you to use colours and display values and labels.

• Your tile is now ready

19.4 FAQ

If you have any questions about using the plugin, please consult our FAQ
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BÖLÜM 20

Anonymize

20.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A basic licence (or higher) is required. This plugin is also available from the Cloud.

20.2 Install the plugin

• Go to the marketplace. Download and install the “Anonymize” plugin.
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20.3 Choice of profile

Anonymisation works by profile. There are 4 profiles already created. When you select a profile, a certain amount of
data is already set. They can, of course, be modified.

• Go to Administration > Anonymization profile and select the profile best suited to your needs:

The 4 profiles you will find are :

• Email

• Entity

• Computer

• User profile

20.4 Anonymisable data per profile (predefined)

Each profile has an element assigned to it. You will need to define the value of each attribute that it will be able to
anonymise (or not)

148 Bölüm 20. Anonymize



GLPI plugins Documentation

20.4.1 Email

• users_id

• is_default

• email

20.4.2 Entity

• name

• entities_id

• comment

• level

• sons_cache

• ancestors_cache

• address

• postcode

• town

• state

• country

• website

• phonenumber

• fax

• email

• admin_email

• admin_email_name

• from_email

• from_email_name

• noreply_email

• noreply_email_name

• replyto_email

• replyto_email_name

• notification_subject_tag

• ldap_dn

• tag

• authldaps_id

• mail_domain

• entity_ldapfilter
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• mailing_signature

• cartridges_alert_repeat

• consumables_alert_repeat

• use_licenses_alert

• send_licenses_alert_before_delay

• use_certificates_alert

• send_certificates_alert_before_delay

• certificates_alert_repeat_interval

• use_contracts_alert

• send_contracts_alert_before_delay

• use_infocoms_alert

• send_infocoms_alert_before_delay

• use_reservations_alert

• use_domains_alert

• send_domains_alert_close_expiries_delay

• send_domains_alert_expired_delay

• autoclose_delay

• autopurge_delay

• notclosed_delay

• calendars_strategy

• calendars_id

• auto_assign_mode

• tickettype

• max_closedate

• inquest_config

• inquest_rate

• inquest_delay

• inquest_URL

• autofill_warranty_date

• autofill_use_date

• autofill_buy_date

• autofill_delivery_date

• autofill_order_date

• tickettemplates_strategy

• tickettemplates_id

• changetemplates_strategy
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• changetemplates_id

• problemtemplates_strategy

• problemtemplates_id

• entities_strategy_software

• entities_id_software

• default_contract_alert

• default_infocom_alert

• default_cartridges_alarm_threshold

• default_consumables_alarm_threshold

• delay_send_emails

• is_notif_enable_default

• inquest_duration

• date_mod

• date_creation

• autofill_decommission_date

• suppliers_as_private

• anonymize_support_agents

• display_users_initials

• contracts_strategy_default

• contracts_id_default

• enable_custom_css

• custom_css_code

• latitude

• longitude

• altitude

• transfers_strategy

• transfers_id

• agent_base_url

20.4.3 Computer

• entities_id

• name

• serial

• otherserial

• contact

• contact_num
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• users_id_tech

• groups_id_tech

• comment

• date_mod

• autoupdatesystems_id

• locations_id

• networks_id

• computermodels_id

• computertypes_id

• template_name

• manufacturers_id

• users_id

• groups_id

• states_id

• ticket_tco

• uuid

• date_creation

• last_inventory_update

• last_boot

20.4.4 User

• name

• password

• password_last_update

• phone

• phone2

• mobile

• realname

• firstname

• locations_id

• language

• use_mode

• is_active

• comment

• auths_id

• authtype
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• last_login

• date_mod

• date_sync

• profiles_id

• entities_id

• usertitles_id

• usercategories_id

• password_forget_token

• password_forget_token_date

• user_dn

• personal_token

• personal_token_date

• api_token

• api_token_date

• cookie_token

• cookie_token_date

• isd_ldap

• picture

• begin_date

• end_date

• page_layout

• fold_menu

• fold_search

• savedsearches_pinned

• timeline_order

• itil_layout

• richtext_layout

• date_creation

• groups_id

• users_id_supervisor

• timezone

• default_central_tab

• nickname

• timeline_action_btn_layout

• timeline_date_format

• use_flat_dropdowntree_on_search_result
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20.5 Application strategy

Several strategies are available for each element field (e.g.Last name, First name, Serial number, Location, Status, etc.):

• Keep the value

• Delete the value

• Replace with a fixed value

• Replace with a standard random value

• Replace with a realistic random value

20.6 History

Each profile allows you to choose the treatment to be applied to the history of items:

• Do nothing

• Clean up values

• Clean up recent values and delete the rest

• Delete

20.7 Global search

You can ask GLPI to anoymise an attribute in the whole database and not only in the type of element you are in. The
option attributes to search and replace in others objects is at the very bottom of your profile.

Not: You cannot change any values other than those linked to the type of element you are in. For example, you will be
able to modify all email addresses in the database via the Email profile, but you will not be able to modify all user
phone number via this profile.

20.8 Applying the profile

Once you have completed your profile, you need to apply it. It can be applied using 2 methods:

• Massive action via the web interface (cloud and on-premise)

• In CLI (only on-premise)
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20.8.1 Mass action (Cloud and on-premise)

In our example, we will be anonymising user data.

• Go to Administration > Users. Select the user(s) you wish to anonymise.

• Click on Actions then anonymise selected items.

Not: “To be adapted If your profile concerns entities, go to Administration > Entities and repeat the operation for the
entities concerned. Do the same for computers, email, etc.

20.8.2 Via CLI (on-premise only)

• Go to your GLPI folder (/var/www/glpi or other depending on your configuration):

• Run all default profiles on all objects:

$ php bin/console glpi:plugin:anonymize --all

• Run profile X on all objects / on one object:

$ php bin/console glpi:plugin:anonymize --profile=X
$ php bin/console glpi:plugin:anonymize --profile=X --item-id=X

• Run default profile type X on all objects / on one object :

$ php bin/console glpi:plugin:anonymize --itemtype=X
$ php bin/console glpi:plugin:anonymize --itemtype=X --item-id=X

20.9 Creating a profile

You can create a profile to anonymise other data than that mentioned above.

• Go to Administration > Anonymisation profile

• Click on Add

• Name your profile

• Choose from the list of Element types (agent, domain, etc.)

• Select the treatment of the History

• Set the parameters for each field

• Click on Add

Not: Remember to refer to the profile application section to apply your changes.
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20.10 Other anonymisable data (profile creation)

20.10.1 Agents

• deviceid

• entities_id

• name

• agenttypes_id

• last_contact

• version

• locked

• itemtype

• items_id

• useragent

• tag

• port

• threads_networkdiscovery

• threads_networkinventory

• timeout_networkdiscovery

• timeout_networkinventory

• remote_addr

• use_module_wake_on_lan

• use_module_computer_inventory

• use_module_esx_remote_inventory

• use_module_remote_inventory

• use_module_network_inventory

• use_module_network_discovery

• use_module_package_deployment

• use_module_collect_data

20.10.2 Appliances

• entities_id

• Garder

• name

• appliancetypes_id

• comment

• locations_id
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• manufacturers_id

• applianceenvironments_id

• users_id

• users_id_tech

• groups_id

• groups_id_tech

• date_mod

• date_creation

• states_id

• externalidentifier

• serial

• otherserial

• is_helpdesk_visible

• pictures

• contact

• contact_num

20.10.3 Budgets

• name

• entities_id

• comment

• begin_date

• end_date

• value

• template_name

• date_mod

• date_creation

• locations_id

• budgettypes_id
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20.10.4 Cables

• name

• entities_id

• itemtype_endpoint_a

• itemtype_endpoint_b

• items_id_endpoint_a

• items_id_endpoint_b

• socketmodels_id_endpoint_a

• socketmodels_id_endpoint_b

• sockets_id_endpoint_a

• sockets_id_endpoint_b

• cablestrands_id

• color

• otherserial

• states_id

• users_id_tech

• cabletypes_id

• comment

• date_mod

• date_creation

20.10.5 Changes

• name

• entities_id

• status

• content

• date_mod

• date

• solvedate

• closedate

• time_to_resolve

• users_id_recipient

• users_id_lastupdater

• urgency

• impact
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• priority

• itilcategories_id

• impactcontent

• controlistcontent

• rolloutplancontent

• backoutplancontent

• checklistcontent

• global_validation

• validation_percent

• actiontime

• begin_waiting_date

• waiting_duration

• close_delay_stat

• solve_delay_stat

• date_creation

• locations_id

20.10.6 Certificates

• name

• serial

• otherserial

• entities_id

• comment

• template_name

• certificatetypes_id

• dns_name

• dns_suffix

• users_id_tech

• groups_id_tech

• locations_id

• manufacturers_id

• contact

• contact_num

• users_id

• groups_id

• is_autosign
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• date_expiration

• states_id

• command

• certificate_request

• certificate_item

• date_creation

• date_mod

20.10.7 Clusters

• entities_id

• name

• uuid

• version

• users_id_tech

• groups_id_tech

• states_id

• comment

• clustertypes_id

• autoupdatesystems_id

• date_mod

• date_creation

20.10.8 Contacts

• name

• firstname

• phone

• phone2

• mobile

• fax

• email

• contacttypes_id

• comment

• usertitles_id

• address

• postcode

• town
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• state

• country

• date_mod

• date_creation

• pictures

20.10.9 Databases

• entities_id

• name

• size

• databaseinstances_id

• is_onbackup

• is_active

• date_creation

• date_mod

• date_update

• date_lastbackup

20.10.10 Datacenters

• name

• entities_id

• locations_id

• date_mod

• date_creation

• pictures

20.10.11 Server rooms

• name

• entities_id

• locations_id

• vis_cols

• vis_rows

• blueprint

• datacenters_id

• date_mod
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• date_creation

20.10.12 Documents

• name

• filename

• filepath

• documentcategories_id

• mime

• date_mod

• comment

• link

• users_id

• tickets_id

• sha1sum

• is_blacklisted

• tag

• date_creation

20.10.13 Domains

• name

• entities_id

• domaintypes_id

• date_expiration

• date_domaincreation

• users_id_tech

• groups_id_tech

• comment

• template_name

• is_active

• date_mod

• date_creation
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20.10.14 Enclosures

• name

• entities_id

• locations_id

• serial

• otherserial

• enclosuremodels_id

• users_id_tech

• groups_id_tech

• template_name

• orientation

• power_supplies

• states_id

• comment

• manufacturers_id

• date_mod

• date_creation

20.10.15 Groups

• entities_id

• name

• comment

• ldap_field

• ldap_value

• ldap_group_dn

• date_mod

• groups_id

• level

• ancestors_cache

• sons_cache

• is_requester

• is_watcher

• is_assign

• is_task

• is_notify
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• is_itemgroup

• is_usergroup

• is_manager

• date_creation

20.10.16 Knowledge base

• name

• answer

• is_faq

• users_id

• view

• date_creation

• date_mod

• begin_date

• end_date

20.10.17 ITIL Categories

• entities_id

• itilcategories_id

• name

• comment

• level

• knowbaseitemcategories_id

• users_id

• groups_id

• code

• ancestors_cache

• sons_cache

• is_helpdeskvisible

• tickettemplates_id_incident

• tickettemplates_id_demand

• changetemplates_id

• problemtemplates_id

• is_incident

• is_request

• is_problem
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• is_change

• date_mod

• date_creation

20.10.18 Followups

• itemtype

• items_id

• date

• users_id

• users_id_editor

• content

• is_private

• requesttypes_id

• date_mod

• date_creation

• timeline_position

• sourceitems_id

• sourceof_items_id

20.10.19 Followups templates

• date_creation

• date_mod

• entities_id

• name

• content

• requesttypes_id

• is_private

• comment

20.10.20 Solutions

• itemtype

• Keep

• items_id

• solutiontypes_id

• solutiontype_name
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• content

• date_creation

• date_mod

• date_approval

• users_id

• user_name

• users_id_editor

• users_id_approval

• user_name_approval

• status

• itilfollowups_id

20.10.21 Lines

• name

• entities_id

• caller_num

• caller_name

• users_id

• groups_id

• lineoperators_id

• locations_id

• states_id

• linetypes_id

• date_creation

• date_mod

• comment

20.10.22 Locations

• entities_id

• name

• locations_id

• comment

• level

• ancestors_cache

• sons_cache

• address
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• postcode

• town

• state

• country

• building

• room

• latitude

• longitude

• altitude

• date_mod

• date_creation

20.10.23 Monitors

• entities_id

• name

• date_mod

• contact

• contact_num

• users_id_tech

• groups_id_tech

• comment

• serial

• otherserial

• size

• have_micro

• have_speaker

• have_subd

• have_bnc

• have_dvi

• have_pivot

• have_hdmi

• have_displayport

• locations_id

• monitortypes_id

• monitormodels_id

• manufacturers_id
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• is_global

• template_name

• users_id

• groups_id

• states_id

• ticket_tco

• autoupdatesystems_id

• uuid

• date_creation

20.10.24 Network devices

• entities_id

• name

• ram

• serial

• otherserial

• contact

• contact_num

• users_id_tech

• groups_id_tech

• date_mod

• comment

• locations_id

• networks_id

• networkequipmenttypes_id

• networkequipmentmodels_id

• manufacturers_id

• template_name

• users_id

• groups_id

• states_id

• ticket_tco

• uuid

• date_creation

• autoupdatesystems_id

• sysdescr
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• cpu

• uptime

• last_inventory_update

• snmpcredentials_id

20.10.25 PDUs

• name

• entities_id

• locations_id

• serial

• otherserial

• pdumodels_id

• users_id_tech

• groups_id_tech

• template_name

• states_id

• comment

• manufacturers_id

• pdutypes_id

• date_mod

• date_creation

20.10.26 Projects

• name

• code

• priority

• entities_id

• projects_id

• projectstates_id

• projecttypes_id

• date

• date_mod

• users_id

• groups_id

• plan_start_date

• plan_end_date
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• real_start_date

• real_end_date

• percent_done

• auto_percent_done

• show_on_global_gantt

• content

• comment

• date_creation

• projecttemplates_id

• template_name

20.10.27 Projects tasks

• uuid

• name

• content

• comment

• entities_id

• projects_id

• projecttasks_id

• date_creation

• date_mod

• plan_start_date

• plan_end_date

• real_start_date

• real_end_date

• planned_duration

• effective_duration

• projectstates_id

• projecttasktypes_id

• users_id

• percent_done

• auto_percent_done

• is_milestone

• projecttasktemplates_id

• template_name
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20.10.28 Devices

• entities_id

• name

• date_mod

• contact

• contact_num

• users_id_tech

• groups_id_tech

• comment

• serial

• otherserial

• locations_id

• peripheraltypes_id

• peripheralmodels_id

• brand

• manufacturers_id

• is_global

• template_name

• users_id

• groups_id

• states_id

• ticket_tco

• autoupdatesystems_id

• uuid

• date_creation

20.10.29 Phones

• entities_id

• name

• date_mod

• contact

• contact_num

• users_id_tech

• groups_id_tech

• comment
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• serial

• otherserial

• locations_id

• phonetypes_id

• phonemodels_id

• brand

• phonepowersupplies_id

• number_line

• have_headset

• have_hp

• manufacturers_id

• is_global

• template_name

• users_id

• groups_id

• states_id

• ticket_tco

• autoupdatesystems_id

• uuid

• date_creation

• last_inventory_update

20.10.30 Printers

• entities_id

• name

• date_mod

• contact

• contact_num

• users_id_tech

• groups_id_tech

• serial

• otherserial

• have_serial

• have_parallel

• have_usb

• have_wifi
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• have_ethernet

• comment

• memory_size

• locations_id

• networks_id

• printertypes_id

• printermodels_id

• manufacturers_id

• is_global

• template_name

• init_pages_counter

• last_pages_counter

• users_id

• groups_id

• states_id

• ticket_tco

• uuid

• date_creation

• sysdescr

• last_inventory_update

• snmpcredentials_id

• autoupdatesystems_id

20.10.31 Problems

• name

• entities_id

• status

• content

• date_mod

• date

• solvedate

• closedate

• time_to_resolve

• users_id_recipient

• users_id_lastupdater

• urgency
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• impact

• priority

• itilcategories_id

• impactcontent

• causecontent

• symptomcontent

• actiontime

• begin_waiting_date

• waiting_duration

• close_delay_stat

• solve_delay_stat

• date_creation

• locations_id

20.10.32 Racks

• name

• comment

• entities_id

• locations_id

• serial

• otherserial

• rackmodels_id

• manufacturers_id

• racktypes_id

• states_id

• users_id_tech

• groups_id_tech

• width

• height

• depth

• number_units

• template_name

• dcrooms_id

• room_orientation

• position

• bgcolor
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• max_power

• mesured_power

• max_weight

• date_mod

• date_creation

20.10.33 Rules

• entities_id

• sub_type

• ranking

• name

• description

• match

• is_active

• comment

• date_mod

• uuid

• condition

• date_creation

20.10.34 Saved searches

• name

• type

• itemtype

• users_id

• is_private

• entities_id

• query

• last_execution_time

• do_count

• last_execution_date

• counter
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20.10.35 Software

• entities_id

• name

• comment

• locations_id

• users_id_tech

• groups_id_tech

• is_update

• softwares_id

• manufacturers_id

• template_name

• date_mod

• users_id

• groups_id

• ticket_tco

• is_helpdesk_visible

• softwarecategories_id

• is_valid

• date_creation

• pictures

20.10.36 Licenses

• softwares_id

• softwarelicenses_id

• level

• entities_id

• number

• softwarelicensetypes_id

• name

• serial

• otherserial

• softwareversions_id_buy

• softwareversions_id_use

• expire

• comment
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• date_mod

• is_valid

• date_creation

• locations_id

• users_id_tech

• users_id

• groups_id_tech

• groups_id

• is_helpdesk_visible

• template_name

• states_id

• manufacturers_id

• contact

• contact_num

• allow_overquota

• pictures

• ancestors_cache

• sons_cache

20.10.37 Solutions templates

• entities_id

• name

• content

• solutiontypes_id

• comment

• date_mod

• date_creation

20.10.38 Solutions types

• name

• comment

• entities_id

• date_mod

• date_creation
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20.10.39 Suppliers

• entities_id

• name

• suppliertypes_id

• address

• postcode

• town

• state

• country

• website

• phonenumber

• comment

• fax

• email

• date_mod

• date_creation

• is_active

• pictures

20.10.40 Task categories

• entities_id

• taskcategories_id

• name

• comment

• level

• ancestors_cache

• sons_cache

• is_active

• is_helpdeskvisible

• date_mod

• date_creation

• knowbaseitemcategories_id
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20.10.41 Task templates

• entities_id

• name

• content

• taskcategories_id

• actiontime

• comment

• date_mod

• date_creation

• state

• is_private

• users_id_tech

• groups_id_tech

20.10.42 Tickets

• entities_id

• name

• date

• closedate

• solvedate

• takeintoaccountdate

• date_mod

• users_id_lastupdater

• status

• users_id_recipient

• requesttypes_id

• content

• urgency

• impact

• priority

• itilcategories_id

• type

• global_validation

• slas_id_ttr

• slas_id_tto
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• slalevels_id_ttr

• time_to_resolve

• time_to_own

• begin_waiting_date

• sla_waiting_duration

• ola_waiting_duration

• olas_id_tto

• olas_id_ttr

• olalevels_id_ttr

• ola_ttr_begin_date

• internal_time_to_resolve

• internal_time_to_own

• waiting_duration

• close_delay_stat

• solve_delay_stat

• takeintoaccount_delay_stat

• actiontime

• locations_id

• validation_percent

• date_creation

• ola_tto_begin_date

20.10.43 Ticket tasks

• uuid

• tickets_id

• taskcategories_id

• date

• users_id

• users_id_editor

• content

• is_private

• actiontime

• begin

• end

• state

• users_id_tech
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• groups_id_tech

• date_mod

• date_creation

• tasktemplates_id

• timeline_position

• sourceitems_id

• sourceof_items_id

20.10.44 Ticket templates

• name

• entities_id

• comment

20.11 FAQ

If you have any questions about using the plugin, please consult our FAQ
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Approval by mail

21.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: standard license (or higher) is required. This plugin is also available from the Cloud.

21.2 Install the plugin

• Go to the marketplace. Download and install the plugin ApprovalByMail.
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21.3 Using the plugin

Once activated, there are no specific settings to be made (apart from the notification layout, if you wish, via Setup >
Notifications > Notification templates. The template is Tickets validation)

• In a new ticket, enter the name of the person or group receiving the approval request.

An email will be received with the option of Validating or Refusing the request. This contains 3 links (if no changes
have been made to the model).

• The ticket reminder

• The acceptance link

• The refusal link

• When the form is validated, you are redirected to GLPI with a notification of acceptance:

• If the form is refused, a comment will be requested to validate the refusal:

• It is not possible to reply 2 times to the validation, an error message will be displayed:
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21.4 FAQ

If you have any questions about using the plugin, please consult our FAQ
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Branding

22.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A basic licence (or higher) is required. This plugin is also available from the Cloud.

22.2 Install the plugin

• Go to the marketplace. Download and install the Branding plugin.
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22.3 Customize your instance

• Go to administration > entities > branding tab

Here you can replace :

• the logo at top left (including folded bar)

• the logo on the login page,

• the background of the login page,

• the icon in the browser bar

22.4 Custom by entity

You can modify certain elements by entity:

• the logo at top left (including folded bar)

• the icon in the browser bar

Other customisations are common to all entities
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22.5 Recommendations

• Top Left corner logo - This can be changed according to the desired entity It is the logo you see when your
GLPI page is opened and the left sidebar is expanded

Default recommended size: 100x55 pixels

• Lop Left corner logo (collapsed sidebar) - This can be changed according to the desired entity It is the logo you
see when your GLPI page is opened and the left sidebar is collapsed.

Default recommended size 40x40 pixels

• Favicon It is the logo you see next to the page title at the beginning of your browser’s the tab.

Default recommended size: 16x16 or 32x32 pixels

• Login page logo It is the logo you see before you login. It appears with the fields to fill with your username and
password

Default recommended size: 220x130 pixels

• Login page background It is the image you can add as a background at the login page.

Default recommended size: It depends on the usual size of your screens. The bigger, the better. (Make sure not to
surpass the maximum upload limit for files)

22.6 FAQ

If you have any questions about using the plugin, please consult our FAQ
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Collaborative tools

23.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A basic licence (or higher) is required. This plugin is also available on Cloud.

23.1.1 Install the plugin

• Go to the marketplace. Download and install the plugin Collaborative tools.

191

https://services.glpi-network.com/#offers
https://glpi-network.cloud/fr/
http://creativecommons.org/licenses/by-nc-nd/4.0/


GLPI plugins Documentation

23.1.2 Activate webhooks

• In the tab Setup > Notifications activate Webhooks notifications

23.1.3 Mattermost

• From a Mattermost administrator account, go to the menu at the top left,

• Then Integrations

• Select Incoming Webhooks

• Then Add a new incoming webhook.

• Fill in the necessary fields and select the channel that will receive the notifications

• Then click on Save.

• You will then be sent the link to your Webhook:
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23.1.4 Telegram

• From Telegram, start a new chat with the bot @BotFather and run the following command /newbot

• Answer the few questions you will be asked to set up your bot

• Once finished, a token will be sent to you:

• If you have already created a dedicated channel to receive GLPI notifications, add your bot to it.

• Otherwise, create your own channel

• add the newly created bot

• Send a message in the channel created to initiate a conversation and generate the various IDs we will need.
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• From your browser, enter the following URL:

https://api.telegram.org/botmytoken/getupdates

Replace mytoken with the value of the token generated above

Not: Telegram bot URLs take the form https://api.telegram.org/bot{mytoken}

• You should see a similar result:

"ok": true,
"result": [

{
"update_id": 816584684,
"my_chat_member": {

"chat": {
"id": -541684658463,
"title": "GLPI Ticket",
"type": "channel"

},
"from": {

"id": 1546610935,
"is_bot": false,
"first_name": "xxxxxxx",
"last_name": "xxxxxxx"

},
"new_chat_member": {

"user": {
"id": 7468746847,
"is_bot": true,
"first_name": "glpi",
"username": "xxxxxx_bot"

• In the my_chat_member copy the ID value of the chat.

Uyarı: The negative sign - must also be copied

23.1.5 Teams

• From a Teams administrator account, go to the channel that will receive GLPI notifications

• Click on the channel menu

• Then Manage channel

• In the Connectors section,

• click on Modify

• From the incoming Webhook connector

196 Bölüm 23. Collaborative tools

https://api.telegram.org/botmytoken/getupdates
http://creativecommons.org/licenses/by-nc-nd/4.0/


GLPI plugins Documentation

23.1. Requirements (on-premise) 197



GLPI plugins Documentation

• click on Configure

• Enter a name for your webhook and an image (optional)

• Click on Create

• You will then be sent the URL of your webhook

23.1.6 Rocket

• You need to add an application to your team (the link is present in the bottom of the left sidebar) and select
incoming-webhook

• Add a new configuration, select the channel where you want notifications and you will get the webhook url.

• You can optionally setup a name and a logo for your hook.

23.1.7 Slack

• As a logged team administrator, go to the administration menu

• click on Integrations menu item

• Click on the New integration button

• Select incoming webhooks, and define webhook parameters

• After save, you will get the url of the webhook.
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23.1.8 Set up the webhook in GLPI

• Fill in the requested information and select the channel on which you want the notifications to be sent.

• Once registered, a link will be sent to you. Copy this link and transfer it to Setup > Notifications > Configuration
of notifications by webhooks

• Click on + and enter :

– Webhook name,

– the type,

– the URL.

• Click on Add

Uyarı: For Telegram, you will need to re-enter the webhook and add the chat_id you selected earlier

• You can test how it works by selecting your webhook and clicking on Send notification
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23.1.9 Recipients

• You now need to determine which notifications will be affected by the sending of a Webhook and assign them a
template.

• Go to Setup > Notifications > Notifications

• Select the 1st notification concerned by Webhooks (here New ticket)

• In the Recipients tab, add your Webhook then Update.

23.1.10 Templates

• In the tab Templates click Add a template

• Choose Webook in the Notification method and New in the Notification template

Your Webhook is ready to use. You can customise the template by clicking on New so that it matches your
requirements.
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23.1.11 FAQ

If you have any questions about using the plugin, please consult our FAQ
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GDPR Tools

24.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A basic license (or higher) is required. This plugin is also available from the Cloud.

24.2 Install the plugin

• Go to the marketplace. Download and install the GDPR Tools plugin.
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24.3 Configure the plugin

• From Setup > General > GDPR tools

24.3.1 Cleaning up inactive users

There are two possible ways of managing inactive users:

• Clearing the user’s data

• Deleting the user

24.3.2 Cleaning up user data

When the plugin is configured in Clean mode, the following actions will be performed:

• Delete all references to the user from the GLPI history

• Delete all associated emails

• Reset all user fields and profiles

• Move the user to the recycle bin

24.3.3 Delete the user

When the plugin is configured in “Delete” mode, the following actions will be performed:

• Delete all references to the user from the GLPI history

• Delete all associated emails

• Delete the user

Uyarı: Deletion is permanent, the user cannot be recovered

24.3.4 Scope restriction

The automated deletion process can be restricted to the following scopes:

• All inactive users

• Inactive users with no current tickets

• Inactive users without tickets
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24.3.5 Automated action

Deletion will take place via a standard GLPI automatic action that can be configured to run as often as you like.

• Go to Setup > Automatic actions, and select the cleaninactiveuser action then configure it according to your
needs.

24.4 FAQ

If you have any questions about using the plugin, please consult our FAQ
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GLPI AI

25.1 Requirements

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

• Open AI API key (free or paid plan) (https://platform.openai.com/api-keys)

• Open AI organization ID (https://platform.openai.com/account/organization)

Not: A basic license (or higher) is required. This plugin is not available from the Cloud.

25.2 Install the plugin

• Go to the marketplace. Download and install the GLPI AI plugin.
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25.3 Create an organization

After creating an OpenAI account, your can create an organization from your account settings under the Organization
tab or by accessing the page directly at https://platform.openai.com/account/organization.

Keep the Organization ID value, as you will need to insert it in the GLPI AI plugin configuration.
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25.4 Create a secret

• From this URL https://platform.openai.com/api-keys

• Click on Create a new secret

• Give a name to your secret

• Click on Create secret key

Copy the secret value that is generated as you will need it later to configure the plugin.
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25.5 Set up GLPI

• In GLPI, go to Setup > General > GLPI AI

• Fill in the fields with the values copied previously

• If your configuration is correct, you will be able to see your account entries, your consumption and your prefe-
rences.

25.6 Consumption

It is possible to limit the use of the API by specifying a limit that must not be exceeded. This plugin tracks usage based
on each response from OpenAI. Therefore, you may need to utilize the “Custom usage” field in the configuration to
account for usage outside of the plugin if you want the plugin to account for that in its usage limitation.

1. To limit usage and avoid overruns, specify a value that must not be exceeded. If this limit is exceeded, the plugin
will no longer function until this value is increased.

2. Enter the custom usage if you want to account for previous usage outside of the plugin.
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25.7 Preferences

In preferences, you can set up the response model. In Free mode, you can use the GPT-3.5 Turbo 16K model.

You can find information regarding the other plans and plan limits here

By clicking on Configure preferences, you can setup a context and a role.

• The Context can be a description of your company, your mission, your job in the company. AI needs to understand
your context if it is to respond as pertinently as possible (there is a context by default that you can change).

• The Role is how the AI should respond. Does it have a teaching, advisory or expert role? The role can influence
the tone and level of detail of the response (there is a role by default that you can change).
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25.8 Example

You can see an example of what can be achieved with an exchange that includes a lot of followups. The GLPI AI plugin
summarizes all of the followups to highlight the main information.

If you want another result, you can click on Refresh.
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Holidays

26.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A basic license (or higher) is required. This plugin is also available from the Cloud.

26.2 Install the plugin

• Go to the marketplace. Download and install the Holiday plugin.
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26.3 Set up the plugin

• From Setup > General, in the Holiday tab, enter :

– The Country concerned

– The Number of years to insert

– Clean all previous holidays or not

– Then click on Insert holiday dates
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26.4 Delete a holiday date/period

The list of holiday days can be viewed and modified

• From Setup > Dropdowns,

• enter Closing and click on Closing times

The list of days appears. Let’s assume that the company considers that Easter Monday is not a day off.

• In the search box, enter Easter then Search

• Select all the entries

• Click on Actions

• Delete permanently

26.5 FAQ

If you have any questions about using the plugin, please consult our FAQ
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LDAP Tools

27.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A basic licence (or higher) is required. This plugin is also available from the Cloud.

27.2 Install the plugin

• Go to the marketplace. Download and install the plugin LDAP Tools.
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27.3 Using the plugin

From tools > LDAP Tools, if you have synchronised LDAP directories, they will appear directly.

Each directory has a number of tests which may or may not be validated depending on your configuration:

• Flux TCP

• BaseDN

• LDAP URI

• Bind Auth

• Generic search

• Filtered search

• Attributes

As soon as one of the tests fails, the following tests will not be performed. You must start by correcting the 1st anomaly
before the other tests are run.
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More satisfaction

28.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A basic licence (or higher) is required. This plugin is also available on Cloud.

28.2 Install the plugin

• Go to the marketplace. Download and install the plugin More satisfaction

223

https://services.glpi-network.com/#offers
https://glpi-network.cloud/fr/


GLPI plugins Documentation

28.3 Create a survey

• Once installed, go to Administration > Satisfaction survey

• Click on Add

• Name your survey and set it as active

• Also remember to tick the sub-entity box if you want it to be available to all child entities

• Then click on Add

Uyarı: It is only possible to create one survey per entity. If you wish to create several for different entities, remember
to position yourself in the appropriate entity and do not tick the sub-entity box

28.4 Create a question

• Enter your survey and go to the Question tab

• Click on Add a question

• Select the type of question Yes/No and enter the text that suits you

• Then click Add
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28.5 Create a text field

• In the question tab, click on Add a question

• Select the Text type

• Enter the text to be displayed and click Add

28.6 Create a note

• In the question tab, click on Add a question

• select the Note type

• You can select a score up to 10 and set a default value

• Click on “Add” when you are happy with your settings

28.7 Preview

The preview tab allows you to see what users will receive once their ticket has been closed
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28.8 Translation

You can translate each of the questions asked in the questionnaire into the language of your choice

• Go to the Translations tab

• Choose the language you want and then, question by question, write the translation

28.9 Schedule reminders

In the event of a non-response to the survey, you can send out reminders to follow-up with the user. You can create your
own reminder or select a predefined one

28.9.1 Customised reminder

• Go to the Reminders tab

• Click on Add a reminder.

• Enter a :

– Name

– Type of duration (day or month)

– The duration of the reminder

– Activate your reminder
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28.9.2 Predefined reminder

• Go to the Reminders tab

• Click on Add a predefined reminder

• You will have 3 options to choose from:

• 1 week: reminder every 7 days,

• 2 weeks: reminder every 14 days.

• 1 month: monthly reminder.

• Select the option that suits you and click on Add

28.9.3 Limit the number of reminders

• In the Setup maximum number of days to send reminder section, enter a limit for the Maximum number of
days to send a reminder

Example : If a person has not responded after 3 reminders, GLPI will no longer send reminders and the satisfaction
survey will then remain unanswered

28.10 Set up the automatic action

Survey reminders are sent via an automatic action already created by the plugin. Make sure that this is activated and
set up correctly

• Go to Setup > Automatic actions

• Select the SatisfactionReminder action.
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28.11 FAQ

If you have any questions about using the plugin, please consult our FAQ

228 Bölüm 28. More satisfaction

https://faq.teclib.com/04_Plugins/Satisfaction_survey/
http://creativecommons.org/licenses/by-nc-nd/4.0/


BÖLÜM 29

OAuth SSO

29.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A basic licence (or higher) is required. This plugin is also available from the Cloud.

29.2 External Authentication

The plugin uses GLPI’s External Authentication functionality and to be functional, it needs some initial Setup.

• Go to Setup > Authentication > Other authentication methods

• In the Other authentication transmitted in the HTTP request section

• The Storage fields for the identifier in the HTTP request field must be defined, usually HTTP_AUTH_USER.

• The Delete the domain from identifiers of the form identifier@domain field can be set to Yes or No.

Not: In the case of authentication via SSO, the option Delete the domain of identifiers in the form identi-
fier@domain can be set to Yes, which will allow 2 user records to be merged if they are already present in the database
(internal or LDAP(S)).

Uyarı: Be careful because this option is subject to identity theft. If your application is open to users other than
your own, it is possible that one user could be merged with another. For example, john.doe@mondomaine.fr has a
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namesake but a different email address john.doe@unautredomaine.fr. By deleting the domain, the 2 records will
be merged and the John Does will have the same account.

The users who are going to authenticate themselves will not be known to GLPI, so it is necessary to populate certain
fields to create their record in GLPI with a minimum of information.

The fields that can be retrieved by SSO are as follows:

• Last name : givenName

• First name: familyName

• Email: email

• Email2: email2

• Telephone number: phone

• Mobile: mobile

• Title: title

• Language: language

• Save your Setup

You must also activate the automatic addition of users in GLPI to create them in GLPI at the time of authentication

• In the Setup > Authentication > Setup menu

• The Automatically add users from external authentication sources field must be changed to Yes
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29.3 Fetch information from user profile option

You can choose if you want to retrieve informations from the user profile. In setup > Oauth SSO applications select
yes or no as required.

Önemli: If OAuth SSO is your only source of authentication AND provisioning, we recommend that you set the
Fetch information from user profile option to Yes so that user information can be fetched. Please note that claims
must also be set correctly on the provider side.

If you are using an external provisioning source such as SCIM, we recommend that you set the Fetch information
from user profile option to No so that user information is not overwritten and replaced by that of the OAuth SSO
plugin.

29.4 Entra

29.4.1 Register your application in Entra

First, register your application with your Entra Active Directory (Entra AD) client. This will provide you with an
application ID for your application and allow it to receive tokens.

• Connect to the Entra portal

• Choose your Entra AD tenant by selecting your account in the top right corner of the page. Then select the
Change directory navigation bar, then the desired tenant

• Skip this step if you only have one Entra AD tenant under your account or if you have already selected one

• In the Entra Portal, search for and select Entra Active Directory

• From the left-hand Active Directory menu

• select Application Registrations

• Then New Registration.

• Enter web in the redirect URI and paste the return URL of your GLPI instance:
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29.4.2 Secret and certificate

• In the certificates and secrets tab, create a new secret that will need to be transferred to your Oauth SSO appli-
cation on the GLPI side:

Uyarı: When you click on add, the secret will only be available once. As soon as you leave this page, the secret
will be hidden and we will no longer be able to access it. Remember to store it in a safe place as we will need it
later

29.4.3 Claims

Uyarı: If you are using SSO V2, an additional step is required. The claims on the Entra side must be entered
manually and should preferably be of type ID.

• In the Token configuration tab

• Click on Add an optional claim

• Add the 4 claims below:
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29.4.4 API authorisations

GLPI must be able to read user information in order to use it for connection - In API permissions - Click on the API
already present (Microsoft Graph for our example)

Select :

• email

• offline_access

• profile

• user.read

• Then remember to save your changes.
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29.4.5 Setup GLPI

• Entra AD provides a description with the essential information you need:

• Specify an application name visible to end users.

Copy the values from the fields above:

• Application ID

• The holder ID

• The value of the secret copied in the previous step

Uyarı: Please check that the value of the secret is filled in correctly.If the ID of the secret is copied, your application
will fall into error.
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29.4.6 Explanation of ID field

• 3 values are available in this insert:

1) User Principal Name (UPN): this option will show the full username of the user logging in
(nom.prenom@mondomaine.com for example). If you want only the username to be visible (without the @mon-
domaine.com, see the XXXXXXXXXX paragraph).

2) Entra user ID (OID): this option takes the object ID from the Entra AD. This ID will be used for the user login

3) Email address: This option specifies the user’s email address. This field will be used for the login. If it is empty,
the UPN will be used.

If you need to find your application in the Entra portal, select Application subscriptions, then Display all applications.

29.5 Google

29.5.1 Creating a project

• From your Google console (administrator access is required)

• Go to your organisation then new project

• Enter the name of your project

• Click on Create

• Return to your organisation,

• Select your project
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29.5.2 Setup Oauth access

• From the menu, click on APIs & Services

• Then OAuth consent screen

• Select the type of access that will be granted to the application (internal or external users)

• Then click on Create.

• Enter (as a minimum) a name for the application, an email address for application support and the developer’s
email address (this information is compulsory).

• Click on Save and continue.

• In the Scope section

• Click on Add or remove application fields

• Add auth/userinfo.email auth/userinfo.profile and openid

• Click on Update

• Then Save and continue
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29.5.3 ID settings

• From the Credentials menu

• Click on Create credentials

• Then Oauth client ID.

• Select the type of application Web application

• Enter an application name

• In the Authorized redirect URIs section

• Enter the GLPI Callback URL

Tüyo: Where can I find my callback URL?

• Click on Create

• A page appears with the identifier values. Keep this information as it will be requested in GLPI.
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29.5.4 Setup GLPI

• From Setup > Oauth SSO applications

• Click on Add

• Select Google in the Oauth provider field

• Select the icon that will be visible on the home page

• Enter the Client ID (number 1 on the previous screenshot)

• Enter the Client secret (numbered 2 on the previous screenshot)

• Enter the field user ID1

• Click on Add

From the home page, the new Oauth SSO login option will be visible:

1 the identifier field will be the user’s login. Google user Id represents the unique value for each user generated when the user is created.
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Not: The first time a user logs on, they will be asked to accept access authorisations for their profile

29.6 OKTA

29.6.1 Create application

• First, go to GLPI and download the Oauthsso plugin

• Navigate to the Setup > Oauth SSO applications

• Click on Add

• Keep this window active and retain the callback URL :

• In your OKTA interface, go to Applications

• Create App Integration

• Select option OIDC – OpenID Connect in the 1st insert and Web Application in the second

• Click on Next

• Enter an application name and check the box Client credentials

• Enter the return URL, retrieved above, in Sign-in redirect URIs.
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29.6.2 Assignments

• In the last box, select the option that suits you best (here we authorize all users present in OKTA)

• Finally, click on Save

29.6.3 Setup GLPI

• In GLPI, go back to the Oauth SSO plugin configuration window and enter your OKTA tenant information :

1. Give your provider a name, which will appear on the login page.

2. Indicate this as active

3. Enter OKTA as provider Oauth

4. Enter the application ID found in the application previously created in OKTA

1. Specify the ID field to be mapped with OKTA

2. Specify the customer secret available in OKTA in the previously created application

7. Enter the name of your OKTA instance (https://XXXXXXXXX.okta.com), available in the account creation
confirmation e-mail.
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• Click on Add

• In the plugin, you will see the approval message:

Now that the configuration is complete, you can test it with a user.

29.7 Keycloak

29.7.1 Create a REALM

• After installing keycloak, go to the admin console:

http://XXXXXXXXXX:8080/admin or https://XXXXXXXXXX:8080/admin

• Create your realm by clicking on master at the top left of your screen

• Then create Realm

• Give it a name that suits you

• Click on Create

29.7.2 Create user

• Then go to the Users tab

• Then Create new user (we’ll use a local user, but you can synchronize your LDAP if necessary)

• Create your user according to your needs, remembering to check the Email verified box

• Click on Create once you’ve entered your details.

• Stay in your user file and click on Credentials
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• Then Set pasword

• Configure the user password, taking care to indicate that the password is not temporary

• Click on save then Save password

You can check that your configuration is correct by logging on to the user account console:

http://XXXXXXXXXXX/realms/GLPI/account/#/ or https://XXXXXXXXXXX/realms/GLPI/account/#/

(Remember to adapt the realm name if you haven’t named it GLPI).

You will then be able to connect to the record of the previously created user or one of your LDAP users.
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29.7.3 Create client

Now we can register our GLPI application with Keycloak

• Go to Clients

• Create client

• Give your application a client ID, which you’ll need to pass on to your GLPI Oauth SSO configuration

• Click on next and make sure on the next page that the standard flow and client authentication options are active

• Click on Save

Keep this page active, we’ll come back to it later.
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29.7.4 Setup GLPI

• Go to GLPI

• In Setup > Oauth SSO applications click on add (at the top of your screen)

• Start by retrieving the return URL and pasting it into Keycloak’s valid redirect URIs field

• Back in GLPI’s Oauth SSO plugin configuration, fill in the required fields:

1. Give your provider a name, which will appear on the login page for users

2. Activate this plugin so that it is visible and usable on the login page

3. Choose Keycloak as your Oauth provider

4. Enter the client name set above

5. Retrieve client secret from Keycloak (client, client_name, credentials)

6. Enter the discovery URL: http://mondomaine/realms/monrealms/.well-known/openid-configuration.

• Click on Add

In the plugin, to see the approval message:

Now that configuration is complete, you can test the connection with the user you created earlier, or with your LDAP
user.
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29.8 Rules for assigning authorisations

Remember that Oauth SSO authentication allows only authentication, in the sense that no user management is carried
out following authentication.

In most cases, it will therefore be necessary to establish rules for assigning authorisations to your users (to give them
a profile, for example).

• To do this, go to Administration > Rules > Rules for assigning authorisations to a user.

There are no ‘mandatory’ rules, it’s up to you to create the rule(s) that you feel best suit your needs according to your
available criteria.

For example, a very simple rule

• A very simple rule -> I want my users with SSO authentication to obtain the Self-Service profile.

So I set my criteria and my action :

260 Bölüm 29. OAuth SSO

http://creativecommons.org/licenses/by-nc-nd/4.0/


GLPI plugins Documentation

29.9 Forcing SSO authentication

Using the Oauth SSO application configuration, you can mask the internal database connection field to force the con-
nection with your SSO application

(setup > Oauth SSO applications > setup)

29.10 Resources

• Documentation Oauth SSO client for GLPI

• Documentation Microsoft Configure your App Service Or Entra Functions app to use Entra AD login

• Documentation OKTA Configure single Sign-On options

• Documentation Keycloak Managing OpenID connect Clients
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29.11 FAQ

If you have any questions about using the plugin, please consult our FAQ
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Rename strings

30.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A basic licence (or higher) is required. This plugin is also available from the Cloud

30.2 Download the plugin

• Go to Marketplace. Download and install the plugin Rename GLPI strings
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30.3 Creating an override

• Go to Setup > Rename GLPI strings

• Click on Add and select the appropriate language.

• In the Override tab, click on New override.

• Select the value you wish to change from the drop-down list. You can search directly.

We are going to change the value Computer to PC

• Select computer and enter the singular and plural of the word to be changed in the corresponding fields.

• Click on Save

30.4 Show the change

You may not see the change immediately. To make it appear, log out and then log back in.

Before :

After :
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30.5 FAQ

If you have any questions about using the plugin, please consult our FAQ
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SCIM

31.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A basic licence (or higher) is required. This plugin is also available from the Cloud.

This plugin let you provision your users and groups from an external identity provider using the SCIM protocol. The
update from the directory to GLPI is done “just in time”. Each modification is done on the fly, without any cron. GLPI
is the service provider, and the directory is the identity provider.

Warning, the SCIM API endpoint provided by the plugin must be accessible from the identity provider. If we
talk about Azure or Okta, this particular url should be available from the internet. We suggest strongly to limit the ip
addresses that can access this url (in addition of adding a strong authentication method).
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31.2 Setup

You must declare an identity server in the plugin configuration (You can add any number). Go to Setup > SCIM
Identity servers menu and click the [+ Add] button on top of the page.

Fill at least:

• The name of the server,

• the user applied on GLPI when receiving a request (this will identify the user in th GLPI logs),

• check the “Active” field,

• and submit by clicking the [+ Add] button at the bottom of the form.

You’ll be given an API url you may paste into your identity provider configuration. Check specific provider documen-
tation for more details.

You may set some optional parameters :

• Save requests in logs: if checked, all requests will be saved in the “Historical” tab of your declared server.

• Default server: if checked, this server will be used by default without providing it’s id in the API Url.

• Security: a dropdown of available security methods. Currently implemented:

– None: no security, anyone can access the API.

– Basic: HTTP Basic authentication. You must provide a username and a password.

– Digest: HTTP Digest authentication. You must provide a username and a password.

– Bearer: HTTP Bearer authentication. A long lived (10years) jwt token will be generated.

– OAuth2: OAuth2 authentication. You must provide at least a valid redirection uri. We support the following
flows:

∗ Authorization code.

∗ Client credentials.

Your SCIM server is now ready to receive requests from your identity provider.
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31.3 Providers

• Azure

• Okta

31.4 A Note about passwords sync

Although it’s mentioned in the SCIM specifications, password sync is not always available depending on the provider:

• Azure: not available

• Okta: available

31.5 FAQ

If you have any questions about using the plugin, please consult our FAQ
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BÖLÜM 32

Splitcat

32.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A basic licence (or higher) is required. This plugin is also available from the Cloud.

32.2 Download the plugin

• From the marketplace (Setup > Plugins), download the Splitcat plugin
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32.3 Settings

There are no special settings to be made for this plugin. You can see the effect of the plugin directly when you open a
new ticket.

32.3.1 Before

32.3.2 After

32.4 FAQ

If you have any questions about using the plugin, please consult our FAQ

272 Bölüm 32. Splitcat

https://faq.teclib.com/04_Plugins/Splitcat/
http://creativecommons.org/licenses/by-nc-nd/4.0/


BÖLÜM 33

Translate

33.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A basic licence (or higher) is required. This plugin is also available from the Cloud.

33.2 Introduction

The Translate plugin for GLPI is a handy tool designed to enhance multilingual communication within your GLPI.
Leveraging DeepL’s translation technology, this plugin provides a simple and effective solution for translating elements
in the ticket timeline, fostering seamless collaboration within international teams.

Whether you’re managing projects with teams scattered worldwide or simply aiming to facilitate communication with
users in different languages, the Translate plugin streamlines the translation process within your GLPI instance.
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33.3 Features

• Translate individual timeline elements

• Translate the entire ticket timeline

• Translate a follow-up during composition

• Restrict translation to specific languages

• Restrict translation to specific types of timeline elements

• API usage notification

• Translation rights management

33.4 Requirements

• GLPI version 10.0.10 or higher

• DeepL API token

33.5 Operation

33.5.1 Translating an Element

Translation of a ticket element is done by activating the translation button located at the top right of the element. The
target language will correspond to the user’s preferred language.

If the translation button does not appear, it may be due to various reasons:

• the plugin is not configured

• you do not have the right to translate

• your preferred language is not allowed in the configuration

• the element you want to translate is not allowed in the configuration
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33.5.2 Undo Translation / Display Original Version

Once an element is translated, it will remain so until you request to undo the translation and display the original version.
Displaying the original version is done through the same button used to translate an element, located at the top right of
the element.

33.5.3 Translate Entire Timeline

It is possible to translate the entire timeline at once. To do this, display the additional options menu at the bottom right,
next to the “Save” button. Then, click on “Translate all elements.”
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33.5.4 Undo Translations / Display Original Versions of Entire Timeline

If all timeline elements are translated and you want to display their original versions, display the additional options
menu at the bottom right, next to the “Save” button. Then, click on “Undo translation of all elements.”
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33.5.5 Translating a Follow-up during Writing

It is possible to translate a follow-up before it is sent. To do this, write your follow-up and click on the drop-down menu
at the top right of the follow-up editing window. Finally, select the language in which the follow-up’s content should be
translated.

Once your follow-up is translated, you can revert to the original text by selecting the “Original” option in the previous
language selection menu.

This feature is also available for tasks, validation requests, and solutions.
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If the translation menu does not appear, it may be due to various reasons:

• the plugin is not configured

• you do not have the right to translate

• the element you want to translate is not allowed in the configuration

33.5.6 Persistence of Translations

To reduce character consumption and improve plugin performance, translations are saved in the database. This approach
allows sharing translations among all users, avoiding the need to translate the same element multiple times in the same
language.

Translation requests from a user for an element are also saved, automatically displaying the translated version when
returning to a ticket’s timeline.

If an element is modified, old translations will be considered obsolete. When a user requests a translation,
a new translation will be performed for that element.
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33.6 DeepL API Key

The Translate plugin uses the DeepL translation service. For this, a DeepL API key is required. DeepL offers two API
plans, a free plan (limited to 500,000 characters per month) and a paid plan (at €4.99/month + €0.00002/character).
Both plans are supported by the plugin.

33.6.1 Obtaining the API Key

1. Visit the DeepL website, “API” section (https://www.deepl.com/pro-api)

2. Select a plan

3. Log in or create an account
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4. Enter your personal informations

5. Accept the terms of use and complete the registration
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6. Click on “Account management” to retrieve your API key

7. In the “Account” tab, retrieve your API key at the bottom of the page, in the “Authentication Key for DeepL API”
section
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33.7 Configuration

33.7.1 Initial Configuration

After installing the plugin, it is necessary to enter a DeepL API key.
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33.7.2 Consumption Configuration

Some configuration options are only available if the API key is linked to the paid plan.

Usage

This progress bar allows you to monitor character consumption at the API level.

Allow Exceeding Limit

Allows setting or not setting a monthly limit on character consumption.

> This option is limited to the paid DeepL API plan.

Usage Limit

Allows setting the type of limitation:

• Characters: Limits usage to the number of characters

• Cost: Limits usage to cost

This option is limited to the paid DeepL API plan.

Per Characters / Per Cost

Allows setting the consumption limit corresponding to the type defined above.

For usage limited by cost, monthly subscription fees are not included.

This option is limited to the paid DeepL API plan.
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Maximum Number of Characters Translated per Translation

Allows setting a maximum number of characters translated at once. This configuration is important and filters out overly
large and resource-consuming elements for the API.

33.7.3 Notification Configuration

Enable API Usage Notifications

Allows enabling API usage notifications. Once enabled, alert thresholds are configurable using the “Usage Threshold”
fields. Default value: Yes

Usage Threshold

This option allows setting usage alert thresholds. Requires enabling the “Enable API Usage Notifications” option.
Default values: 25%, 50%, 75%, 100%

33.7.4 User Configuration

Allowed Target Languages for All Users

Defines the languages in which elements can be translated by all users.
Default values: Languages proposed by DeepL

Allowed Translatable Elements for All Users

Defines the elements that can be translated by all users.
Default values: Ticket, Follow-up, Ticket Task, Solution, Validation Request

33.8 Rights

33.8.1 Allow translation of displayed elements (language configured in preferen-
ces)

This right defines whether a profile can translate timeline elements of a ticket (Ticket, Follow-up, Task, Solution,
Validation Request).
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33.8.2 Allow translation while writing

This right defines whether a profile can translate the content of a follow-up before sending.

33.9 FAQ

If you have any questions about using the plugin, please consult our FAQ
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Unread messages

34.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Not: A basic licence (or higher) is required. This plugin is also available on Cloud.

34.2 Install the plugin

• Go to the marketplace. Download and install the plugin Unread messages.
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34.3 Setting up the plugin

• Go to Administration > Entities, unread messages tab

There are 3 possible settings:

Operation Effect
Disabled The plugin will remain inactive
Per user help-
desk;share
central

Users with the self-service profile will be notified of tickets for which they are the requestor.
Technicians, for their part, will share the notifications. If a notification is read, it will be marked
as read for all other technicians

Per user Each user will have access to their own queue of notifications, including those for their group and
their individual assignments

34.4 Display notifications

34.4.1 Header

When a new activity has not yet been viewed, a bell icon appears:

34.4.2 Listed

Unread messages on a ticket highlight the ticket concerned and a red indicator :

34.4.3 Ticket timeline

New messages will be identified by a banner New messages.
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34.4.4 Management by entity

Management by entity is possible to manage the counting of notifications by entity.

• Go to Administration > Entities, and select the desired entity.

• In the Unread messages tab, select the option that suits you so that unread messages behave differently to the
parent entity.

34.5 FAQ

If you have any questions about using the plugin, please consult our FAQ
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